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Preface

About This Book

This book documents version 2.0 of PocketGIS®.

About PocketGIS

PocketGIS is a powerful Geographical Information
System which can display and edit map data.  It can
also be connected to a Global Positioning System
(GPS) receiver for data capture or location tracking.
The system is fully customisable which makes it an
ideal platform for GIS applications.

Facilities provided by PocketGIS include:

• Map display.

• Simultaneous display of map data from
different data sets.

• Zoom / Pan of map display.

• Zoom to grid reference.

• Save and return to named map display areas.
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• Control of map feature visibility via user
defined scale ranges.

• Display of map feature attributes by pointing
with the pen.

• Map feature creation & editing.

• Feature attribute data creation, display, and
editing.

• Capture of coordinate geometry from GPS
receiver.

• Capture of coordinate geometry from laser
rangefinders.

• Print current map display.

• Find features with specified attribute values.

• Capture images from a digital camera.

• Make “sketches” and attach them to features.

• Read bar codes.

Related Books

This book documents the PocketGIS application
which runs on a Windows Mobile device.

Before you attempt to use PocketGIS you should be
familiar with your device and how it’s standard
controls operate.  This will be documented in the
user manual that came with your device.

You should also read the PocketGIS Connection User
Manual which documents how to exchange map data
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between PocketGIS on a mobile device and a desktop
computer.

Information on using the PocketGIS ActiveSync
synchronisation module can be found in the ‘Active
Sync Service Provider’ document which is installed
onto the desktop computer and can be reached via
Start->Programs->PocketGIS->PocketGIS Release
Notes.

This book assumes that the reader is familiar with
Geographical Information Systems.

How to use this book

This book is both an introduction and a reference
guide to PocketGIS.  You must read the first few
chapters carefully in order to learn the basics of
working with PocketGIS.  The later chapters cover
advanced functionality and are best read once you
are familiar with the basic operation of the
application.  However you use this book be sure to
read chapters 2 & 3.

This book has been written to meet the needs of
several different types of users.  Some readers will
be end users for whom the system has been pre-
configured, others will be administrators or expert
users.  There will be times when you encounter
information which is intended for a different type of
user to yourself.  In particular many users will not
be concerned with the “advanced” features
described in the later chapters.

Chapter 1 - Installation & SetupChapter 1 - Installation & SetupChapter 1 - Installation & SetupChapter 1 - Installation & SetupChapter 1 - Installation & Setup.  Follow the
instructions in this chapter to install PocketGIS.
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Chapter 2 - Getting Started.Chapter 2 - Getting Started.Chapter 2 - Getting Started.Chapter 2 - Getting Started.Chapter 2 - Getting Started.  Read this chapter
for an introduction to PocketGIS and an overview of
the main controls.

Chapter 3 - Working with Map ViewsChapter 3 - Working with Map ViewsChapter 3 - Working with Map ViewsChapter 3 - Working with Map ViewsChapter 3 - Working with Map Views explains
essential information on how to work with map data
in PocketGIS.

Chapter 4 - Map ToolsChapter 4 - Map ToolsChapter 4 - Map ToolsChapter 4 - Map ToolsChapter 4 - Map Tools describes tools which
operate directly on the Map Display Area, and on
map features.  You will learn how to create and
modify map data in this chapter.

Chapter 5 - Navigation & Display ToolsChapter 5 - Navigation & Display ToolsChapter 5 - Navigation & Display ToolsChapter 5 - Navigation & Display ToolsChapter 5 - Navigation & Display Tools
explains how to use tools which enable you to
navigate around the map display.

Chapter 6 - General ToolsChapter 6 - General ToolsChapter 6 - General ToolsChapter 6 - General ToolsChapter 6 - General Tools explains how to use
general utility tools.

Chapter 7 - Options Chapter 7 - Options Chapter 7 - Options Chapter 7 - Options Chapter 7 - Options explains how to configure
PocketGIS.

Chapter 8 - Multiple View ModeChapter 8 - Multiple View ModeChapter 8 - Multiple View ModeChapter 8 - Multiple View ModeChapter 8 - Multiple View Mode explains how to
use PocketGIS with more than one Map View.

Chapter 9 - GPS ReceiverChapter 9 - GPS ReceiverChapter 9 - GPS ReceiverChapter 9 - GPS ReceiverChapter 9 - GPS Receiver explains how to
connect a GPS receiver to PocketGIS.

Chapter 10 - Laser RangefinderChapter 10 - Laser RangefinderChapter 10 - Laser RangefinderChapter 10 - Laser RangefinderChapter 10 - Laser Rangefinder explains how to
connect a Laser Rangefinder to PocketGIS and use it
to capture map features.

Chapter 11 - Other DevicesChapter 11 - Other DevicesChapter 11 - Other DevicesChapter 11 - Other DevicesChapter 11 - Other Devices explains how to
connect with Digital Cameras and Bar Code Scanners.

This book also contains a number of appendices:

Appendix A Appendix A Appendix A Appendix A Appendix A - Software LicenseSoftware LicenseSoftware LicenseSoftware LicenseSoftware License - this is the
licence under which you may use PocketGIS.
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Appendix B - Technical Support Appendix B - Technical Support Appendix B - Technical Support Appendix B - Technical Support Appendix B - Technical Support lists the ways
in which you can contact us in the event of a
problem.

Appendix C - GlossaryAppendix C - GlossaryAppendix C - GlossaryAppendix C - GlossaryAppendix C - Glossary provides definitions for
some of the technical terms used in this manual.

Throughout this book samples of Ordnance Survey
Land-Line and ADDRESS-POINT map data appear in
various screen images.  This data is copyright
Ordnance Survey and is reproduced with their kind
permission.

The screen images in this manual are taken from
PocketGIS running on Microsoft® Windows® for the
Handheld PC.  If you are using PocketGIS on a Palm-
size PC or Pocket PC, some of the controls and
dialogs are slightly different in order to accomodate
the smaller screen.  The operation of PocketGIS is
identical on both platforms except in a few cases
which are described within this manual.
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Chapter 1

Installation & Setup

System Requirements

PocketGIS runs on a variety of Microsoft® Windows®
CE based platforms built on Windows CE version
2.11 or later.  Most devices run a standard version of
the operating system e.g. Windows CE .net /
Windows Mobile  / Pocket PC / Handheld PC.
PocketGIS also runs on Windows 2000, Windows XP,
and Windows Vista.
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Installing from the CD

PocketGIS is supplied on a CD-ROM disk which
contains the complete product including the
companion desktop application “PocketGIS
Connection”.

You must install ActiveSync 3.0 (or later) before you
can install PocketGIS.  ActiveSync will have been
supplied with your Windows Mobile device.  Follow
the instructions which came with your device to
install ActiveSync and connect your device to your
PC.  The latest version of ActiveSync can be
downloaded from http:://www.microsoft.com/
mobile.

It is recommended that you run the installer with
your mobile device connected to the desktop
computer via ActiveSync.

Insert the disk into the CD drive of your desktop
Windows computer.  The PocketGIS installer should
start automatically after a few seconds.  If it does
not, run Setup.exe from the top level folder on the
CD.  PocketGIS uses the Windows Installer Service
and this will be automatically upgraded from the CD
if an out of date version is present on your
computer.  Once the installer is ready it will display
the welcome screen.
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If you are asked if you want to remove older
versions of PocketGIS software you should answer
yes to all messages.

Press NextNextNextNextNext and read and accept the terms of the
Software License Agreement.

Make sure you have read and agree to theMake sure you have read and agree to theMake sure you have read and agree to theMake sure you have read and agree to theMake sure you have read and agree to the
software license.  By installing and usingsoftware license.  By installing and usingsoftware license.  By installing and usingsoftware license.  By installing and usingsoftware license.  By installing and using
PocketGIS you are agreeing to the terms ofPocketGIS you are agreeing to the terms ofPocketGIS you are agreeing to the terms ofPocketGIS you are agreeing to the terms ofPocketGIS you are agreeing to the terms of
this license. The licence is also included atthis license. The licence is also included atthis license. The licence is also included atthis license. The licence is also included atthis license. The licence is also included at
Appendix B of this manual.Appendix B of this manual.Appendix B of this manual.Appendix B of this manual.Appendix B of this manual.

You will be asked to select the ‘setup type’.
CompleteCompleteCompleteCompleteComplete will install all the desktop software and
all of the PocketGIS components onto your Windows



1-4

PocketGIS User Manual

mobile device.  Alternatively you can select CustomCustomCustomCustomCustom
and control exactly which components are installed.

Press NextNextNextNextNext and then InstallInstallInstallInstallInstall to install PocketGIS.  If
any mobile device software has been installed the
installation will proceed as described in ‘Mobile
Device Installation Procedure’ below.

If the installer appears to stop while “Performing
Mobile Device Installation” is displayed then look for
“Add / Remove Programs” in the Task Bar and click
on it.  Then respond to the messages that are
displayed as described below.

If you explore the CD you will find copies of the user
manuals in the “Documentation” folder, and copies
of the PocketGIS release notes documents in the
“Release Notes” folder.

Installing PocketGIS

Unlike previous versions, all PocketGIS components
are always installed.  The only exceptions are datum
tables which are very large and are only required in
certain countries.

Mobile Device Installation Procedure

The installation of the mobile device software is a
three stage process.  The first stage involves the
setup program and copies software from the
installation CD onto your desktop computers hard
drive.  The second stage involves the Application
Manager (part of ActiveSync) which transfers the
software onto your mobile device.  Application
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Manager is called “Add / Remove Programs” in
ActiveSync.  The third stage is when the transferred
software is installed on your mobile device.

To install PocketGIS start the main CD installer as
described in “Installing from the CD” above.  The
installer will place software for all mobile platforms
onto your computers hard disk.  There are two types
of installation and you will be given the chance to
choose the one you require.

A CompleteCompleteCompleteCompleteComplete installation will install all components.
Datum tables are required by some map projections
and these will only be installed if your desktop
computer’s regional options locale setting matches
the country these apply to (e.g. British tables are
installed if the regional setting is English (United
Kingdom)).  You can change which components are
installed at any time after the installation is
complete.

A customcustomcustomcustomcustom installation will allow you to choose
which components are installed.  Choose this option
if you want to select which components are installed.

This selection of components determines what is
installed on you desktop machine and carried
forward to the second installation stage in
Application Manager.

The software will be placed in <system
drive>:\Program Files\Microsoft
ActiveSync\PocketGIS or <system drive>:\Program
Files\Windows CE Services\PocketGIS.

Once the software has been copied to your hard disk
the installation program will start the Application
Manager.
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If your Windows CE device is not connected to
ActiveSync when you run the PocketGIS installation
program you will receive the following message:

Connect your device to ActiveSync to install the
application.

If your device is connected to ActiveSync then you
will receive the following message:

Press ‘Yes” to install the selected PocketGIS
components onto your device in the default
application install directory (\Windows\Program
Files\PocketGIS).

Press ‘No’ to install the selected PocketGIS
components onto your device with the opportunity
to select the installation folder.

Press ‘Cancel’ to remain in Application Manager and
choose which components to install.

The components available here will only be those
selected during the first stage installation onto your
desktop computer.

If you press ‘Yes’ the installation will proceed
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automatically and install PocketGIS onto the main
memory of the device.

If you press ‘No’ the selected components will be
copied to your device.  If you have a storage card
inserted into your device a dialog will appear which
allows you to install PocketGIS onto a storage card.
A further dialog will appear on your device which
lets you choose the installation folder.  You can
usually just press the OK button on this dialog and
accept the offered folder.  This is the recommended
procedure.

If you press ‘Cancel’ the Application Manager
window will remain open.
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Tick the components that you want to install and
then press ‘OK’.  You must install PocketGIS.  The
selected components will be installed onto your
device.  There may be further messages displayed on
your mobile device during the third stage - answer
these as appropriate.

Additional Setups

If you will be using PocketGIS most of the time you
may wish to set the handheld devices Taskbar to
auto hide.  This will make more screen area available
for map display.  To do this select Start->Settings-
>Taskbar on your mobile device and tick the ‘Auto
Hide’ checkbox.  Taskbar Auto Hide is not available
on Pocket PC devices.

Release Notes

Supplementary documentation is included with
PocketGIS in the form of ‘Release Notes’ documents
which are placed in the PC install directory (e.g.
C:\Program Files\PocketGIS).  You should read these
documents.  These documents are also available
from the desktop Start->Programs->PocketGIS-
>PocketGIS Release Notes menu and can also be
found on the release CD.

Adding / Removing PocketGIS Components

The installation can be controlled from the desktop
Add / Remove Programs control panel (not to be
confused with Add / Remove Programs in ActiveSync
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which only controls what is installed on the device).
Choosing ModifyModifyModifyModifyModify will allow you to add PocketGIS
Components that may not have been installed
originally.  Removing components will remove the
installer files from the desktop machine, and will
omit them from any reinstall onto the device, but
will not remove them from the device if already
present.

Removing PocketGIS from the Mobile Device

To remove PocketGIS (or any components) from the
mobile device either:

Use the ‘Remove Programs’ control panel or settings
window on your mobile device, or use the RemoveRemoveRemoveRemoveRemove
button in ActiveSync Add / Remove Programs dialog
(The Application Manager) which will remove the
components from the device and also the desktop.

If you are reinstalling or upgrading PocketGIS follow
the procedure described below - otherwise your
options settings will be deleted.

Reinstalling / Upgrading PocketGIS

To reinstall or upgrade from a previous version of
PocketGIS run the installer from the CD with your
device connected to ActiveSync.

If you are reinstalling the current version of
PocketGIS you can select Reinstall PocketGISReinstall PocketGISReinstall PocketGISReinstall PocketGISReinstall PocketGIS from
the desktop Start->Programs->PocketGIS menu
providing the PocketGIS device files are still installed
on the desktop.  If they are missing this option will
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not be available and you should use the CD setup to
reinstall using the ModifyModifyModifyModifyModify, Complete  Complete  Complete  Complete  Complete or Custom Custom Custom Custom Custom
options depending on what is displayed.

For each selected PocketGIS component that is
already on the device you will be asked if you want
to reinstall or upgrade.

Recovering the Installation Following a Power
Loss

Windows mobile devices have backup batteries to
preserve the contents of the machines main memory
if the main battery runs flat.  However, on some
devices it is common to experience the loss of
backup power as well, which means that the entire
contents of the main memory is lost.  Storage cards
to not require battery power to preserve their
contents and you can install PocketGIS onto a
storage card, and also keep your map data on the
card, to prevent their loss when power is exhausted.
Once the batteries have been recharged or replaced
the software and data on the storage card will be
available for use (although any software or data on
the main memory will be lost).  Although the
software is preserved in this circumstance,
important installation information, which must
reside in the main memory, is lost which makes the
functionality provided by PocketGIS components
(e.g. GPS Receiver) unavailable.  You will also loose
your options settings and the software will return to
it’s default configuration.

PocketGIS provides two mechanisms which allow you
to restore from total power loss, if all the PocketGIS
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software is installed on a storage card, without
having to use a third party backup tool.  PocketGIS
can now detect and repair the installation
information in main memory following a power loss.
A method to backup your options settings to a
storage card is also provided.

Installing PocketGIS for Power Loss Recovery

Firstly you need to insert a memory card (or cards)
which has sufficient capacity to hold the PocketGIS
software (circa 2 to 5 Mb) and all your map data.
Some devices have memory expansion modules
which function as storage cards and do not loose
their contents following a power loss.  Storage cards
appear on Windows CE devices as “Storage Card”,
“Storage Card 2”, etc.  Some devices use the name
“Compact Flash”, “Drive”, or “Disk” instead.

Install all the PocketGIS software onto the storage
card.  When running the PocketGIS installer the
ActiveSync Application Manager (also known as
“Add / Remove Programs”) will ask you if you want
to install the software in the “default application
directory”.  Press the N oN oN oN oN o button and select the
Storage Card in the dialog that follows.  When the
software has been transferred to the device a
window will appear asking you to select the location
for the software (this will happen for each
component).  Press O KO KO KO KO K to choose the default folder
for each component which will be in the form
“Pocket Systems <component name>” in the “Storage
Card” folder.  [Note: the only other configuration
that is supported by the power loss recovery
mechanism is installing all components into the
same folder, e.g. “\Storage Card\PocketGIS” but it is
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safer to just accept the default].  If the software is
installed onto a card, removing the card whilst
PocketGIS is running will cause the application, and
possibly the operating system, to crash.

When importing data into PocketGIS always choose
to transfer it onto a storage card.

Once you are happy with your options settings, or
after significant changes, select Options Options Options Options Options from the
PocketGIS PocketGIS PocketGIS PocketGIS PocketGIS menu and go to the Backup Page.  Select
the storage card you wish to backup your options
settings to and press BackupBackupBackupBackupBackup.  Your options will be
saved to the card.  Note that only options will be
backed up, data and software will not be backed up.
If you change your settings make another backup
which will overwrite any previous backup on that
card.

Recovering the Installation Following a Power Loss

Following a complete power loss the PocketGIS item
on the programs menu will no longer be there as the
installation information will have been lost with the
main memory contents.  Use the “Windows Explorer”
(if on a Handheld PC) or other file explorer
application and navigate to the location of the
PocketGIS application.  This will be called
“PocketGIS.exe” (it may appear as just “PocketGIS”
with an application icon) and will be located in
“\Storage Card\Pocket Systems PocketGIS” or
wherever you chose to install the software.  Double
tap the application icon to run PocketGIS.  PocketGIS
will detect that the main memory contents have
been lost and the installation information, including
program menu entries, will be restored.  [Note:
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PocketGIS Connection will not be able to
communicate with PocketGIS until this restoration
has been performed].  Following the installation
restoration, your options settings will then be copied
back into the main memory.  Note, if you did not
make a backup of your options before the power was
lost they cannot be restored.

PocketGIS will now be fully operational.
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Chapter 2

Getting Started

This chapter introduces you to PocketGIS and
provides an overview of its controls.

Starting PocketGIS

You start PocketGIS by double tapping its icon

or selecting PocketGIS from the Start->Programs
menu.
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On a Pocket or Palm-size PC there is no PocketGIS
icon, select PocketGIS from the start menu (or the
Start->Programs menu).  Initially PocketGIS will not
appear on the Start menu of a Pocket PC but can be
found in the Start->Programs window.  You can
move it onto the main Start menu using Settings -
>Menus.
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Application Overview

When you open PocketGIS for the first time it will
look like this:

MenuBar
Map Tools Button

Pan / Zoom Controls

Navigation & Display Tools Button

Map Display Area

The command bar at the top of the screen consists of
a menu bar and a tool bar.  You can hide / expose
the menu and / or toolbar by sliding the vertical
gripper between the menu and the tool buttons.  If
the menu is completely hidden a small menu icon
appears in the top left hand corner of the screen -
tap this to reveal the menu.  If the toolbar becomes
completely hidden a small toolbar icon appears in
the top right hand corner of the screen - tap this to
reveal the toolbar.
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The main elements of the PocketGIS application are
as follows.

Map Display Area

This is the area in which geographical map data is
displayed.  It will be described in the next chapter -
Working with Map Views.

PocketGIS Menu

This menu gives access to information about the
application, options, and the Print command.  If you
have a customised version of PocketGIS other items
may appear here.

View Menu

The View Menu controls the content and appearance
of the map display.  This menu is described in
Chapter 3 - Working with Map Views.

Tools Menu

This menu gives access to various tools such as
controls to delete map data and connect to a GPS
receiver.  These tools are described in Chapter 6 -
General Tools.

Map Tools Button
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This button enables you to access tools which
operate directly on the map and on map features.
These tools are described in Chapter 4 - Map Tools.
Note: a different icon may appear in the Map Tools
button - see the Map Tools chapter for more
information.

Pan / Zoom Controls

These controls are used to Pan and Zoom the
geographical map display.  They are described in
Chapter 3 - Working with Map Views.

Navigation & Display Tools Button

This button provides a menu of controls to navigate
the displayed map.  These controls are described in
Chapter 5 - Navigation & Display Tools.

Customisations

PocketGIS is highly customisable.  You may find that
the some of the buttons described here are not
visible, or that additional buttons are present.  You
may also find that there are additional items on the
menus or that some items are not visible.  This can
happen for one of three reasons:

• The result of a PocketGIS Options setting.
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• A plugin enhancement has been installed.

• This is a customised version of PocketGIS.

Options

Options which control the appearance of PocketGIS
include whether or not the application is in “Single
View Mode”.  These options are described in Chapter
7 - Options.

Plugin Enhancements

Plugin enhancements add functionality to the
standard version of PocketGIS.  These plugins may
have been provided by Pocket Systems or by third
parties.  Plugins can add buttons, menu items, and
preferences to PocketGIS.  Plugins enhance the
application, they do not change the standard
functionality.

Pocket PC Version

The Pocket PC version of PocketGIS has the controls
positioned at the bottom of the screen.
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The Pocket PC user interface is different from the
Handheld and Palm-sized PC.  You cannot choose to
have the Taskbar / Navigation bar auto hide itself.
Also, the menubar is separate from the other
application tool bars and cannot be covered over to
save screen space.

The Pocket PC version of PocketGIS has a full screen
button on the left hand side of the main toolbar.
Pressing this button will put PocketGIS into full
screen mode where the navigation and menu bars
are hidden to provide more space for the map
display.  Pressing the full screen button again will
restore the application to normal mode where the
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navigation and menu bars are available.

When in full screen mode the attributes form will
extend to the top of the screen covering the
navigation bar.

On Handheld and Palm-size PC devices you can
maximize the display area by setting the taskbar to
autohide and dragging the toolbars over the menu.

Customised versions of PocketGIS

You may be using a customised version of PocketGIS.
Customisations can provided enhancements to the
application and also change or remove standard
controls.  You may find that some buttons and menu
items described in this manual do not appear if you
are using a customised version.

Loading Map Data

You view and access map data in PocketGIS via a
Map ViewMap ViewMap ViewMap ViewMap View, or ViewViewViewViewView.  The Map View defines which
map datasets are displayed and their appearance.

You will probably have noticed that when you open
the PocketGIS application for the first time the words
“There are no Map Views available” are displayed at
the top of the Map Display Area.  This is because you
do not have any map data loaded and there are no
Map Views.

To start using PocketGIS you need to load in some
map data from a desktop computer using the
“PocketGIS Connection” application.  Refer to the
PocketGIS Connection User Manual for instructions
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on how to do this.

When you first load in some map data a Map View
will be automatically created.  You will then be able
to view and access the map.  Read the next chapter -
Working with Map Views - to learn how to use and
navigate the map display.
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Working with Map Views

This chapter explains the basic principles of how you
work with map data in PocketGIS.

Map Views

You view and access map data in PocketGIS via a
Map ViewMap ViewMap ViewMap ViewMap View or ViewViewViewViewView.  The terms Map View and View
are used interchangeably throughout this manual.

The Map View determines which map data is
displayed and how and when it appears on the
screen.  The View is literally your view onto the map
data.

When you open PocketGIS for the first time there
will be no Views available - a View will be created for
you the first time you download some map data.
Downloading map data is explained in the PocketGIS
Connection User Manual.
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The map data that is associated with the View will be
displayed in the Map Display AreaMap Display AreaMap Display AreaMap Display AreaMap Display Area.  You can
control the map display using the Pan / ZoomPan / ZoomPan / ZoomPan / ZoomPan / Zoom
ControlsControlsControlsControlsControls in the main toolbar at the top of the
screen - these controls are also available from the
View menu along with other view controls.  These
controls are explained later in this chapter.

By default PocketGIS works in Multiple View Mode.
However, you can configure PocketGIS to work with
single Views which simplifies the View menu - this is
covered in Chapter 8 - Multiple View Mode.

In addition to the Pan / Zoom Controls, View Menu,
and Map View Controls, there are many other tools
which operate on map data.  These controls are
described in the Map Tools and Navigation &
Display Tools chapters.

Once some map data has been loaded, a View will be
created and an initial overview of the map data will
be displayed.

The current scale of the map display appears in the
top right hand corner of the PocketGIS screen.
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Pan / Zoom Controls

The Pan / Zoom Controls in the main toolbar can be
used to navigate around the Map Display.  These
commands are also available from the ViewViewViewViewView menu.

Keyboard shortcuts are provided as indicated in the
menu and button tooltips.

The button on the left of this control group is the
Zoom In ButtonZoom In ButtonZoom In ButtonZoom In ButtonZoom In Button.

This button will increase the resolution of the map
display - a smaller area of the map view will be
displayed at a larger scale.  The centre of the display
will be the same as the previously displayed area.

The button on the right is the Zoom Out ButtonZoom Out ButtonZoom Out ButtonZoom Out ButtonZoom Out Button.
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This button will decrease the resolution of the map
display - a larger area of the map view will be
displayed at a smaller scale.  The centre of the
display will be the same as the previously displayed
area.

The four buttons in the centre of this control group
will pan the display in the direction of the arrow.
The display resolution, or scale, will not change but
the display will be centred on a different location.

Depending on the current display position in the
map display area, these buttons will be either active
-  meaning you can pan or zoom in that direction, or
be inactive (greyed out) - meaning that you cannot
pan or zoom in that direction.  You cannot zoom out
if you are at the maximum extent of the map view
area.  You cannot zoom in if you are at the minimum
extent of the map view area.  Sometimes you will see
that all the Pan / Zoom control buttons are greyed
out and therefore disabled.  This happens when
there are no Map Views available, or the map data
associated with the View is not available (e.g. if it
was on a storage card which you have removed).

You can select ‘Overview’ from the ‘View’ menu - this
will zoom the map display out to the full extent of
the data in the map view.

Composition of Map Views

A Map View is comprised of a number of LayersLayersLayersLayersLayers of
MapMapMapMapMap data.
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Geographical map data is stored in a MapMapMapMapMap.  Each
Map that is loaded into PocketGIS consists of one or
more Layers of geographical data.  For example a
Map of an urban area may have three Layers - one
containing roads, another containing buildings, and
a third containing railways.  Vector Map Layers
contain FeaturesFeaturesFeaturesFeaturesFeatures.  A Feature is a graphical element
such as a line, point, text, area, etc.  Map Views can
also contain Raster Map Layers which display a
scanned image of a map.

A Map View can contain any number of Layers
drawn from any number of Maps.  i.e. the View can
contain Layers from more than one Map.  Also, the
View does not need to contain all the Layers from
each Map.

Each Layer that is included in a View has two other
items associated with it: a LegendLegendLegendLegendLegend and a DisplayDisplayDisplayDisplayDisplay
SchemeSchemeSchemeSchemeScheme.

A Legend defines how the map data is displayed,  i.e.
it defines line styles and symbols.

A Display Scheme defines at which scale individual
map features are displayed.  As you zoom out of a
map display features may no longer be displayed in
order to reduce the density of the map display and
aid clarity.  For example, as you zoom out buildings
may not be displayed past a certain scale, but roads
would still be displayed.

Legends and Display Schemes are setup using
PocketGIS Connection.  The creation and
modification of Legends and Display Schemes is
discussed in the PocketGIS Connection User Manual.
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The View Menu

The View Menu provides various items which control
the Map Display Area.

The Zoom / Pan item provides menu based access to
the pan and zoom commands described earlier in
this chapter.  The Modify item is described in
‘Modifying a View’ later in this chapter.  Additional
commands that can appear on this menu are
described in Chapter 8 - Multiple View Mode.

The second part of the View menu contains a list of
the layers in the current view.

You can use the View menu to turn the display of
layers on and off.  If there is a to the left of a Layer
name, then that Layer is currently displayed.  If you
tap on the Layer’s name then the map display will
redraw without data from that Map Layer.  If there is
a space on the left of a Layer then that layer is not
currently displayed.  If you tap on the Layer’s name
then the map display will redraw with data from that
Layer.

If a Layer name is greyed out then the Layer cannot
be displayed at the moment.  This could be because
none of the data from that Layer will display at the
current scale.  For example,  if the Layers’ Display
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Scheme was set so none of it’s data was displayed
above a scale of 1:50,000, and you zoomed out to
1:100,000 - the Layer’s name would be greyed out.
This is nothing to worry about - it’s for your
information.  If the Map Display Area goes blank
after a Zoom Out operation - check the View Menu to
see if the data has gone out of range.

The Layer name will also be greyed out if the Layer’s
Map, Legend, or Display Scheme is missing (if you
haven’t deleted the map then it was almost certainly
on a card you have removed).

Modifying a View

You modify a View via the Modify View dialog.  This
is accessed by selecting the Modify  item of the View
Menu.
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The dialog shows the View’s name and a list of
Layers that the View contains.  The buttons at the
bottom of the dialog can be used to configure the
View’s Layers.

Name

The Name item can be used to change the name of
the View.  Naming Views is useful in Multiple View
Mode which is described in Chapter 8.

Location

The LocationLocationLocationLocationLocation item allows you to choose whether
the View is stored in main memory or on a storage
card.

Add

The Add  Button will display the Add Layer dialog.
This dialog can be used to add a Layer to a View.
The Add Layer dialog is described later in this
chapter.
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Modify

The Modify  Button will display the Modify Layer
dialog for the Layer that is selected in the Layer list.
This dialog is described later in the chapter.

Delete

The Delete  button will remove the selected Layer
from the View.

Up / Down Buttons

These are used to change the priority of Layers in
the View.  PocketGIS draws Layers is reverse priority
order.  The Layer at the bottom of the list is drawn
first, and the Layer at the top of the list draws last.
You can use these controls to define the drawing
order, i.e. which layers are drawn over the top of
other Layers.  To change the priority of a Layer tap
on it’s name in the list and then tap U pU pU pU pU p or DownDownDownDownDown.

Modifying a Layer

To modify a Layer first bring up the Modify View
dialog as described in the previous section.  Select
the Layer you wish to modify in the Layer list and
tap the Modify  button.  The Modify Layer dialog will
be displayed.
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The dialog shows the Layer’s name and provides
controls which can be used to configure the Layer.

Name

The Name item can be used to change the name of
the Layer in this View (it does not change the name
of the Layer in the Map).

Legend

This item shows the name of the Legend that is
currently being used to display the features of this
Layer.  Legends control line styles and symbology.
The popup list allows you to select from other
Legends that have been created for this Layer.
Normally there will only be one Legend available.

Display Scheme

This item shows the name of the Display Scheme
that is currently being used by this Layer.  Display
Schemes define at which scales map features are
drawn.  The popup list allows you to select from
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other Display Schemes that have been created for
this Layer.  Normally there will only be one Display
Scheme available.

Adding Layers to a View

To add a Layer first bring up the Modify View dialog
as described in the previous section.  Tap the Add
button - the Add Layer dialog will be displayed.

Use the Map popup list to select the Map from which
you want to include map data.

Use the Layer  popup list to select the Layer which
you want to add to the View.

The Name item allows you to give the Layer a name.
This name does not need to be the same as the
original name of the layer.

Tap the Add  button to add the Layer.
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Printing a View

You may print the current map display using the
Print  command on the PocketGIS menu.

This command will display the standard Windows CE
print dialog which will allow you to select the printer
and other options.  PocketGIS will centre the current
map display within the chosen paper size and extend
the draw area to fill the page.

You can extend the printing capabilities of your
device by purchasing third party print drivers and
software.

Please see the PocketGIS Release Notes document for
further notes on printing.

Note that at the time of writing, printing is not
available in the Palm-size PC / Pocket PC version of
PocketGIS.



3-13

Working with Map Views



3-14

PocketGIS User Manual



4-1

Chapter 4

Map Tools

This chapter explains how to use tools which interact
directly with the Map Display Area and Map
Features.

These tools enable you to:

• Pan / Zoom by pointing.

• Measure distances from the map.

• Measure areas from the map.

• Display the grid reference of a point.

• Display and change information about a map
Feature.

• Change the geometry of a map Feature.

• Capture new map Features.
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The Map Tools Button

The Map Tools Button is located in the main toolbar
at the top of the screen.

Tapping the Map Tools Button displays the MapMapMapMapMap
Tools MenuTools MenuTools MenuTools MenuTools Menu which provides a list of the Map Tools
available at the current time.

You use the Map Tools Menu to select which tool is
currently active.  When you tap in the Map Display
Area the action that occurs depends on which Map
Tool is selected.  The icon displayed on the Map
Tools Button changes to reflect the selected tool - the
Map Tools Menu shows which tool is selected with a
dot.

When you start PocketGIS the current Map Tool is
the Pan / Zoom ToolPan / Zoom ToolPan / Zoom ToolPan / Zoom ToolPan / Zoom Tool.

You will find that not all the Map Tools are always
available.  Map data can be stored in one of two
formats: Read Only and Read / Write.  Since some of
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the Map Tools are used to create and change map
features, if your View does not contain any read /
write data then the Geometry and Capture Tools will
be greyed out.

If you have an enhanced or customised version of
PocketGIS you may find that the list of Map Tools is
different to that described here.  Refer to
supplementary documentation for information on
Map Tool Enhancements.

The Pan / Zoom Tool

The Pan / Zoom Tool allows you to pan and zoom
the map display using the pen directly on the Map
Display Area.  This tool should not be confused with
the Pan / Zoom Controls described in the previous
chapter.

First make sure that the Pan / Zoom Tool is selected.

If the icon in the Map Tools Button is not  then
tap the button and select Pan / Zoom .
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You can pan the map display by tapping on the map
location that you would like to appear in the centre
of the display - the screen will then redraw, at the
same scale, with that location at the centre.

You can zoom in to a chosen area by dragging out a
box on the display.  The display will zoom to show
the area contained within the box you have drawn.
You can drag the box in any direction you like (top
left to bottom right, top right to bottom left, bottom
left to top right, etc.).

If whilst you are dragging the box you decide you
have made a mistake, you can abort the zoom in by
moving the pen back to the point you started from -
the box will shrink to nothing and you will hear a
warning sound - lift the pen and the operation will
be cancelled.

If you choose a pan location which is near the edge
of the maximum view extent, the location will not
always be redrawn in the centre of the display.  The
map display is constrained so it will not move
outside the maximum extent of the View.
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Sometimes you may find that dragging a zoom box
does not increase the scale of the map display.  This
happens when you are at the minimum zoom extent.

You can use the Pan / Zoom tool even if it is not
selected as the current map tool.  If you hold down
the shift key whilst tapping or dragging a pan /
zoom operation will be performed.  Also the map
display will zoom in, or out, when the user presses
the numeric keypad add (+, zoom in) or subtract (-,
zoom out) keys (if these are present on your device).
Some devices have In and Out buttons which
correspond to these keys and zoom the display in or
out.

The Grid Reference Tool

The Grid Reference Tool will display the coordinate
position of a map location you indicate with the pen.

First make sure that the Grid Reference Tool is
selected.  If the icon in the Map Tools Button is not

 then tap the button and select Grid Reference .
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Tap on the map location for which you want the grid
reference.

A small popup will appear showing the grid
reference.  The position of the grid reference (i.e.
where you tapped) is shown by an .  The reference
is in the coordinate system of the map data you have
loaded and is displayed in the current Display Units
(e.g. meters).  You can change the display units in
Options which are described in Chapter 7.  The +/-
indicates the error in the reference due to screen
resolution.  In the example shown the error is 1m.

If you tap close to a map feature the coordinate will
be calculated from the underlying map data and will
therefore be entirely accurate.  If a map feature
coordinate is displayed you will hear the “OK” beep
when you tap and the grid reference display will not
contain a +/- error.

If you want another grid reference simply tap in the
required location.  If you want the current grid
reference to disappear tap the grid reference text.

The Identify Tool
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The Identify Tool will display a description of a map
feature you select with the pen.

First make sure that the Identify Tool is selected.  If

the icon in the Map Tools Button is not  then
tap the button and select Identify .

Tap on the feature you are interested in.  You will
need to tap very close to the feature in order to
select it.

If you hear an error sound then no feature was
selected.  If you hear the OK sound then the feature
will be highlighted and a description of the feature
will be displayed in a popup.
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If you want to identify another feature simply tap in
the required location.  If you want the current
identification to disappear tap the feature
description.

If you have a feature selected in the Identify Tool,
and then switch to the Attribute or Geometry tools,
the feature selection will be retained.

The Distance Tool

The Distance Tool allows you to measure the
distance between two feature points which you select
with the pen.

First make sure that the Distance Tool is selected.  If
the icon in the Map Tools Button is not  then
tap the button and select Distance .
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The prompt “Tap first point...” will appear at the top
of the map display area.  Tap on the first feature
point.  If a feature point is not selected then the
error sound will be played.  If a feature point is
selected then the OK sound will be played and the
point will be marked with a circle cross.  The prompt
will change to “Tap second point...”.

Tap on the second feature point.  If a feature point is
selected then the OK sound will be played and the
point will be marked with a circle cross.  The
distance between the two points will be displayed in
the current display units as a popup text item.
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If you want to make another measurement simply
tap on a feature point and repeat the steps described
above.  If you want the current distance to disappear
tap the popup text.

The Area Tool

The Area Tool allows you to measure the area
enclosed by a linear map feature which you select
with the pen.

First make sure that the Area Tool is selected.  If the

icon in the Map Tools Button is not  then tap
the button and select Area .
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Tap on the feature whose enclosing area you wish to
calculate.  You will need to tap very close to the
feature in order to select it.

If you hear the error sound then no feature was
found near your tap, or the feature was not a line or
area, or it did not have at least three points.

If you tap close enough to a line or area feature then
you will hear the OK sound, the feature will be
highlighted, and it’s enclosing area will be displayed.
If a line feature does not close back on itself the final
“closing” segment will be assumed by the
calculation.
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If you want to measure another area simply tap on
the required feature.  If you want the current area to
disappear tap the popup text.

The Attributes Tool

The Attributes Tool will display the attributes
associated with a map feature you select with the
pen.

First make sure that the Attribute Tool is selected.  If

the icon in the Map Tools Button is not  then
tap the button and select Attributes .

Tap on the feature you are interested in.  You will
need to tap very close to the feature in order to
select it.
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If you hear the error sound then no feature was
selected.  If you hear the OK sound then the feature
will be highlighted and the Attributes Dialog will be
displayed.

The Attributes dialog shown above is how it will
appear for a feature from a read / write map with
attributes.

If you have a feature selected in the Attribute Tool,
and then switch to the Identify or Geometry tools,
the feature selection will be retained.  The Attribute
tool will continue to highlight the currently selected
feature even after the form has been closed.

Attribute Field Editors

The attribute editors allow you to view, enter, or
change the attribute values.  The configuration of
the attribute edit fields depends on how the data
was configured in PocketGIS Connection - see the
PocketGIS Connection User Manual for details.
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Many fields allow you to type in values.  If the field
has a  - tap this to bring up a list of values.  In
some cases this will be a list of recent values to save
you having to type in values again.  Some fields are
configured so you cannot type in a value but can
only select from a popup value list.  The date field
has a popup calendar - you can also select a date
element such as month and use the keyboard arrow
keys to step through values.  The time field allows
you to type in numbers or use arrow keys to step
though values.  Other possibilities are a tabbed
alphabetic popup; a popup consisting of images
which you can select from; sketch and image
buttons.  Sometimes an attribute may have been
defined as read only.  You cannot edit read only
values.  Some values, such as areas & line lengths
may have been configured to update themselves
automatically.  On Pocket and Palm-sized PC devices
many text entry fields automatically adopt title case
without the need to press the shift or caps key.

Sketch Pad

Sketch attributes allow you to attach a sketch and
type written notes to a feature.  Sketch attributes
appear with a Sketch  button in the Attributes Form.
Pressing the Sketch  button displays the Sketch Pad
which allows you to enter text and drawings.
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Use the OK or Close (X) buttons to leave the Sketch
Pad which save, or discard, the changes respectively.
Note that the Sketch will not be stored in the
database until you save the Attributes Form changes.

The Sketch Pad is built from the standard Windows
CE Rich Ink control and so the appearance and
capability of the Sketch Pad differs with the
operating system version.  Most of the
documentation for the built in Ink Writer, Note
Taker, and Notes applications (depending on which
one is available on a particular platform) will apply
to the PocketGIS Sketch Pad.
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In all versions you can make the sketch larger by
drawing off the page.  All versions also have controls
similar to those found in word processors for
editing, undo / redo, etc.

The version present in the Handheld PC (CE 2.0) lets
you choose the mode from the Tools menu or the
toolbar.  You can choose between Ink (drawing and
handwriting), Select (typing and moving drawings),
and Space (inserting space into the sketch).
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The version present in the Palm-size PC (CE 2.01 &
2.11) lets you choose the mode from the Tools menu
or the toolbar.  You can choose between Select
(typing and moving drawings), Space (inserting
space into the sketch), and neither of these (drawing
and handwriting).  See the online help for the built
in Note Taker application for more details on using
the controls.

The version present in the Handheld PC Professional
(CE 2.11) lets you choose the mode from the View
menu (the toolbar changes with the mode).  You can
choose between Typing, Writing, and Drawing.  This
version also has more advanced controls for
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grouping and editing elements of the sketch
document such as may be found in word processing
applications - see the online help for the built in
InkWriter application for more details on using these
controls.

The version present in the Pocket PC (CE 3.0) lets
you choose the mode by pressing, or releasing, the
draw button on the menu bar.  You can choose
between drawing and typing mode.  The Edit menu
has conventional editing commands plus a revert
option which will restore the sketch to the state it
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was in when you opened the sketch pad.  The View
menu allows you to set the mode and the zoom
factor.

Image Attributes and the Image Selector / Browser

Image attributes allow you to attach an image such
as a digital photograph to a feature.  Image
attributes appear with an Image button in the
Attributes Form.  Pressing the Image  button displays
the Image Select window which allows you to select
an image to be assigned to the attribute.

Use the OK or Close (X) buttons to leave the Image
Selector which save, or discard, the changes
respectively.  Note that the Image assignment will
not be stored in the database until you save the
Attributes Form changes.
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If the Image Capture Options are set (See Chapter 5)
additional access to a remote camera or a camera
application on your device is possible.

Press the Browse  button to display the Image
Browser which will display images from storage
memory - such as a memory card which has been
taken from a digital camera.  Navigate to the
location of the images you want to browse, select one
of them, and press OK.  If you are browsing a digital
camera memory card the images will be in sub
folders of the storage card - see your camera
documentation for details (or just explore).  Only
JPEG image files can be displayed.  When you have
selected the browse folder the Image Browser will be
displayed allowing you to view and select from all
the images at that location.
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The File menu provides the options to browse a
different folder and also to delete a selected image
(you cannot delete an image that has been protected
using camera or operating system commands).
Select the image you want to assign by tapping on it
and press OK.  You can also double tap the image to
select and assign it in one action.  The browser will
close and the selected image will appear in the Image
Selector.
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Press the Select  button to select an image file without
viewing thumbnail images.  The chosen file is
selected and it’s thumbnail image displayed in the
Image Selector window.

The operation of the Browse and Select functions is
slightly different when running on a Palm-sized or
Pocket PC, than when running on a Handheld PC.
On a Handheld PC pressing either the Browse or
Select buttons brings up the standard “open file”
dialog which allows you to browse to anywhere in
the available storage mediums.  On Pocket and Palm-
sized PC devices you can only browse to files which
are stored under “My Documents” - this is the
standard operation on these devices.  To allow direct
access to images on a storage card removed from a
digital camera, the Pocket and Palm-sized PC
versions of PocketGIS will automatically detect a
digital camera storage card.  If such a card is
detected the “open file” dialog will not appear and
the browser will automatically show all the images it
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can find on the card.  Similarly the select function
will display a list of the images on the card which
you can choose from.  If you want to select form files
under “My Documents” remove the camera card, the
browse and select functions will then show the “open
file” dialog.

You can clear the assignment of an image by
pressing the Clear  button in the Image Selector.

Once an image has been selected, the checkboxes
control what happens when you press OK to close
the Image Selector and make the assignment.

Copy image into the PocketGIS Database  will copy the
image file from it’s current location into the
PocketGIS Database containing the feature whose
attributes you are changing.  If the image is already
in the particular PocketGIS Database this checkbox
will be disabled.  Delete the original image  will remove
the image file from it’s current location once it has
been copied.  If the source image file is protected (by
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camera or operating system command), or the image
is already located in a PocketGIS Database, the delete
option will be disabled.

Press OK in the Image Selector to complete the
assignment and perform any copy and / or delete
operation.  If there was an image previously assigned
to the attribute, and it is located in the PocketGIS
Database to which the current feature belongs, you
will be asked if you want to delete the previous
image - this will save storage space if the image is no
longer required.

It is a good idea to always copy images into the
PocketGIS Database if you have the storage space
available.  If you choose to assign images without
copying them you will need to ensure that they are
available in their original location whenever they are
required - such as for viewing in the attributes form
or export.  This requires that the card they are
stored on is inserted in the machine (you can
remove it in-between times, to take more pictures
for example).  Note that if you are working with
more than one storage card in a Windows CE device
the second card will be called “Storage Card2” (the
third “Storage Card3”, etc) and these names can
change if you take cards out and move them around.
If you assign images without copying them make
sure the storage card retains the same name in
Windows CE - if it was called “Storage Card” when
the images were assigned, and is later called
“Storage Card2”, the images will not be located.  If
you always use the same slot for the card containing
the images you should be alright.
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Note that the Image Selector / Browser works best
with JPEG files which have thumbnail images
encoded within them.  Images from digital cameras
generally have thumbnails.

Attribute Function Button

The Attribute Function Button provides a list of
commands.

Tap the function button to bring up a menu of
functions.

Note that there may be other commands on the
function menu which have been provided by plugin
components.

Defaults

The defaults function will set any empty attributes
to predefined values.  Attributes which already have
values are not affected by the defaults function.  The
defaults function will only set values for which there
is predefined default.  If selecting this function does



4-26

PocketGIS User Manual

nothing, or it is greyed out, it is because there were
no default values supplied for these attributes when
the map data was downloaded.

Revert

If you modify any feature attributes then the Revert
Function will be available.

Selecting the Revert Function will revert the feature’s
attributes back to the values held when you opened
the Attributes Dialog.  Revert is not undoable - you
will be warned about this before the operation is
completed.

Undo

You can undo the last change you made to an
attribute by selecting the undo function.

Print

To print a list of the attributes for a feature, select
PrintPrintPrintPrintPrint.

Shortcut Functions

There are two shortcut functions on the menu.

The Geometry Shortcut function will switch from the
Attributes Tool to the Geometry Tool for this
feature.  This allows you to edit the current features
geometry without having to choose the Geometry
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Tool in the Map Tools Menu, or select the feature
again.  The Geometry Tool is described later in this
chapter.

The Capture Shortcut function will switch from the
Attributes Tool to the Capture Tool.  This allows you
to start capturing new map features without having
to choose the Capture Tool in the Map Tools Menu.
The Capture Tool is described later in this chapter.

Feature Type

The Feature Type popup is in the top left hand
corner of the Attributes Dialog and allows you to
change the type of a feature.

Changing the feature type can cause attributes
which are not defined on the new feature type to be
discarded.  You will be warned about this before the
features type is changed.

Other forms of the Attributes Dialog

The appearance of the Attributes Dialog is different
for different types of data.  All the examples shown
so far are for read / write data with attributes.

If a read / write feature without attributes is selected
using the Attributes Tool the Attributes Dialog looks
like this:
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Notice that the Feature Type popup and function
button are still available.

If a feature from a read only map is selected the
Attributes Dialog will look like this:

The attributes are displayed but you cannot change
them.

The Geometry Tool

The Geometry Tool allows you to modify the
geometry of a map feature.

First make sure that the Geometry Tool is selected.

If the icon in the Map Tools Button is not  then
tap the button and select Geometry .
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When the Geometry Tool is active the Geometry
Toolbar appears at the top of the screen.

You can move the Geometry Toolbar by dragging the
“gripper” on it’s left hand edge.

Select the feature you want to modify.  You will need
to tap very close to the feature in order to select it.

If you hear the error sound then no feature was
selected.  If you hear the OK sound then the feature
will be highlighted.

If you have a feature selected in the Geometry Tool,
and then switch to the Attribute or Identify tools,
the feature selection will be retained.
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The example above shows the Geometry Tool when a
line feature has been selected.

The feature type is displayed at the top of the screen
- in this case “General Line Detail”.

If you tap the Geometry Function Button a menu of
edit actions is displayed.
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The items in the first group change the current edit
action, nothing happens until you interact with the
map display.  The items in the subsequent groups
are performed immediately and do not change the
current edit action.  Select the action you require
from the menu.  If the item you select is in the first
group then the button’s icon will change to indicate
the current edit mode.

Note that there may be other commands on the
function menu which have been provided by plugin
components.

Each of the points that make up the line will have
been highlighted with a symbol.  The meaning of
these symbols is as follows:
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The round cross indicates the current edit point.
This is the point that Move and Add edit actions
apply to.

The square cross indicates the backward edit point.
The significance of this is described below.

The normal cross is used to highlight the position of
the other points of the line.

You can change the current edit point (the one with
the circle) by tapping very close to one of the other
points in the line.

In the above example the next point was tapped.
This point then becomes the current edit point and
is highlighted with a circle.
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Move

To move a point first make sure that Move Point is
the current edit action and the point you want
moved is highlighted with the circle symbol.  If the
current edit action is not Move Point , tap the
Function Button and select Move Point from the
menu.

Next tap on the location you want the current edit
point moved to.  The display will adjust to show the
modified geometry.

You can select the Undo Function to reverse any of
the geometry actions.
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Selecting Undo in the example above will reverse the
Move Action.

Add

The Add action will add a new point to the line.  The
point will be added between the current edit point
(shown by the circle symbol) and the backward edit
point (shown by the square symbol).
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To add a point first make sure that Add Point  is the
current edit action and the current and backward
edit points are either side of the line vertex that will
contain the new point.  If the current edit action is
not Add Point , tap the Function Button and select Add
Point from the menu.

Next tap on the point you want to add.  The display
will adjust to show the modified geometry.

Add Before

The Add Before action works in exactly the same way
as the Add action, except that the point is inserted
before  the current edit point, rather than after it.
The example below shows what happens if exactly
the same point is chosen for the add, but with Add
Before  selected as the edit action.
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Delete Point

Selecting Delete Point  from the Function Menu will
delete the current edit point, i.e. the point shown
with circle symbol.  If this action was selected using
the example above the line would be modified and
appear as shown in the next example.

Delete Feature

The Delete Feature Function will erase the feature.
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You can undelete the feature by selecting the Undo
Function.  You must, however, do this immediately
after the delete operation.

Snapping

The Snap Button is a toggle, press it once to push it
in, press it again to release it.  When the Snap button
control is depressed, the points you enter during
add and move operations will be snapped to existing
map geometry.  The new point will either take the
exact coordinates of a snapped to point, or a line
intersection will be calculated for a snapped to line.
You can also toggle snapping by typing Ctrl+S.

Snapping only occurs within a certain (very small)
tolerance so you will need to tap very close to a
point or line in order to snap to it.

You will have noticed that when you enter a move or
add point you hear an OK sound.  When the snap
control is checked you only here the OK sound when
the new point position is snapped.  If a point or line
was not found within the search tolerance, the new
point is still used - but a warning sound is played
instead.

Snapping does slow down the edit operations so you
should only have the snap control depressed when
you want snapping to happen.

If you have a customised version of PocketGIS the
snap control may not be visible.
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Shortcut Functions

There are two shortcut functions on the bottom of
the Function Menu.

The Attributes Shortcut Function will switch from
the Geometry Tool to the Attributes Tool for this
feature.  This allows you to edit the current features
attributes without having to choose the Attributes
Tool in the Map Tools Menu, or select the feature
again.  The Attributes Tool is described earlier in
this chapter.

The Capture Shortcut Function will switch from the
Geometry Tool to the Capture Tool.  This allows you
to start capturing new map features without having
to choose the Capture Tool in the Map Tools Menu.
The Capture Tool is described later in this chapter.

Ending the Edit

When you have finished editing the feature, or wish
to select a different feature, press the End Edit
button (or type Ctrl+E).
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Editing Areas

Editing area features is the same as editing lines.
The area function menu has the same options as the
line menu.

Editing Points

If you use the Geometry Tool to select a point, a
slightly different version of the Function Menu is
available.  The principles and main controls are the
same as for line features.

The Move action allows you to tap on a new location
for the point.

The Delete Feature  action will delete the point.

Revert  works exactly as described for line features
above.

If you have selected a rotated symbol an additional
option, Rotate , will be available.
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To rotate a point first make sure that Rotate  is the
current edit action.  If the current edit action is not
Rotate , tap the Function Button and select Rotate
from the menu.

Tapping points in a circle around the point will
cause its rotation to change.

Editing Text

Editing text features is the same as editing points.
The text function menu has the same options as the
point menu.

Setting Points With GPS

You can use the Geometry Tool to move or add
points using coordinates from a GPS receiver.  To do
this you need to connect PocketGIS to a GPS receiver.
See Chapter 9 for instructions on how to connect to
a GPS receiver.
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While you are connected to a GPS receiver the GPS
button is enabled.

You can tap the GPS button at any time instead of
tapping on the map display - the current GPS
location will be used to digitise the next point.  (You
can also type Ctrl+G).  If the edit action is “move”
then current edit point is moved to the GPS position;
for other modes a new point is added at the GPS
position.

The GPS button will only remain enabled while the
GPS receiver is reporting a valid position.
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The Capture Tool

The Capture Tool allows you to create new map
features.

First make sure that the Capture Tool is selected.  If

the icon in the Map Tools Button is not  then
tap the button and select Capture .

When the Capture Tool is active the Capture Toolbar
appears at the top of the screen.

You can move the Capture Toolbar by dragging the
“gripper” on it’s left hand edge.

First select the type of feature you wish to capture -
tap on the Feature popup.
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A list of feature types will be displayed.  The
contents of the list will depend on which feature
types are included in the current Map View.  Note:
only features from read / write maps are included in
the list, also some features may have been
configured so they cannot be captured.

Select the feature type you wish to capture.

Note: when you re-enter the Capture Tool it will
normally default to the feature type you last
selected.

The Snap     Button works in exactly the same way as
already described for the Geometry Tool.  The snap
control may not appear if you have a customised
version of PocketGIS.

The Function Button provides a menu of commands
which are appropriate at various stages during the
capture process.  The icon in the function button
changes depending on whether the capture feature
is a line, point, text or area.  Note that there may be
additional commands on the function menu which
have been provided by plugin components.

To capture this feature, which is a line, tap on the
location of the first point.  The point location will be
shown with a circle cross.
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Then tap on the remaining points in the line.

At any time you can press the Function Button to
select any function that is available at that stage of
the capture operation.

The Create function will create the new feature.

The Close and Create  function will add a final point
which is the same as the first point (thus closing the
line back on itself) and create the feature.
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The Devices  sub-menu is described in the GPS and
Laser Rangefinder chapters.

The Undo function will undo the last change to the
feature.

The Cancel Capture  option will discard all the points
that have been captured for this feature (previous
features will not be affected).

The Pause function allows you to pause capture of
the current feature.  When you select this function
the current geometry will be saved and the Capture
Tool will appear as if no geometry has been
captured.  You can then capture another feature
which can be of another type.  You can pause as
many features as you like.

The Resume  sub menu provides a list of all paused
features.  The features are listed in the order that
they were paused (i.e. the last feature paused will be
at the end of the menu) and the menu item gives the
feature type and the number of geometry points
captured in brackets.  To resume capture of a
feature select it from the Resume  menu.

The Delete Last Point function will remove the last
point that was captured.
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You can also press the End Edit button (or type
Ctrl+E) to create the feature.

Once you have created the new feature it will be
highlighted and the Delete Feature  function will be
available from the function menu.

If you have a feature selected in the Capture Tool,
and then switch to the Attribute, Identify or
Geometry tools, the feature selection will be
retained.

The Shortcut Functions

When a feature has been created the two shortcut
functions will be available from the Function Menu.

The Attributes Shortcut Function will switch from
the Capture Tool to the Attributes Tool for this
feature.  This allows you to edit the new features
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attributes without having to choose the Attributes
Tool in the Map Tools Menu, or select the feature
again.  The Attributes Tool is described earlier in
this chapter.

The Geometry Shortcut Function will switch from the
Capture Tool to the Geometry Tool for this feature.
This allows you to edit the new features geometry
without having to choose the Geometry Tool in the
Map Tools Menu, or select the feature again.  The
Geometry Tool is described earlier in this chapter.

Capture Information Display

When capturing line or area features a display
appears in the bottom right hand corner of the
screen.  This displays the length of the last vertex
and the total length of the the line.  The last vertex
length is the value displayed at the top.  If a GPS
position is available the distance from the GPS
location and the last captured point is also displayed
- prefixed by “G:”.

Capturing Area Features

If you select an area feature from the Feature popup
the Capture Function Menu will be configured for
areas.  Capturing areas is almost the same as
capturing lines except:

• You must capture at least 3 points before you
can create an area.
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• The area “Create” function is a close & create.
The feature is always closed back on itself.  This
means that you do not need to capture the last
“closing” point of an area.

Capturing Point Features

If you select a point feature from the Feature popup
a the Capture Function Menu will be configured for
points.

Tap on the location of the new point feature, if this
is a non rotatable point then the new feature will be
created immediately.

As for lines, the Point function menu will allow you
to delete the newly created point.

Capturing Rotated Points

You capture rotated points by entering two taps.

The first tap defines the location of the point.
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A second tap indicates the rotation angle of the
point.  On the second tap the point feature will be
created.  If you select the Create Function, press the
End Edit Button, or type Ctrl+E after the first tap, the
point feature will be created with no rotation.

You can only rotate a feature that has been
predefined as rotatable.

Capturing Text Features

You capture text features in exactly the same way as
point features.

Capturing Another Feature

When you have captured a feature using the Capture
Tool, you can immediately capture another feature
by tapping it’s location on the map display.  If the
next feature is of a different type to the first, use the
feature popup to select the new type.

Capturing GPS Points

You can use the Capture Tool to capture coordinates
from a GPS receiver.  To do this you need to connect
PocketGIS to a GPS receiver before you open the
Capture Tool dialog.  See Chapter 9 for instructions
on how to connect to a GPS receiver.
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While you are connected to a GPS receiver the GPS
button is enabled.

You can tap the GPS button at any stage of a capture
operation instead of tapping on the map display -
the current GPS location will be used to digitise the
next point.  (You can also type Ctrl+G).

The GPS button will only remain enabled while the
GPS receiver is reporting a valid position.  If the
receiver cannot provide the position then the GPS
button will temporarily become disabled.  It will be
re-enabled again once the GPS position has been re-
established.  GPS receivers often loose track of your
position when their view of the satellites is obscured
by buildings or trees.

Edit Functions

This section explains how to use the “Edit Functions”
available in the Geometry & Capture Tools.

The edit functions described in this section are:

• Aligned Offset

• Bilaterate Point

• Parallel Offset
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Accessing Edit Functions

The Edit Functions are accessed from the Edit
Functions  menu which appears on the Geometry and
Capture Tool function menu.

Some functions operate via a number of steps.  You
can restart a function at any time by re-selecting it
from the function menu.  The current function is
indicated with a tick in the menu.  You can stop a
function by selecting Cancel Function  from the menu,
or by selecting another function.  You can repeat a
step by selecting Undo  from the function menu.

Aligned Offset

The Aligned Offset function allows you to digitise a
point, along an imaginary line, between two selected
feature points.  You will be asked for the distance
along the line at which to create the point.

To use this function first select Aligned Offset  from
the current tool’s function menu.
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The following caption will appear at the top of the
map display area:

Select the first vertex on the map display.  The
selected vertex will be marked with a circle cross:

You will be prompted for the second vertex.  Select
the second vertex, you will then be prompted for the
distance.
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Enter the distance.  A point will be digitised at the
given distance along an imaginary line from the first
selected vertex, towards the second selected vertex.

Bilaterate Point

The Bilaterate Point function allows you to digitize a
point by bilateration from existing map detail.

To use this function first select Bilaterate Point  from
the current tool’s function menu.
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The following caption will appear at the top of the
map display area:

Select the first vertex on the map display.  The
selected vertex will be marked with a circle cross:

You will be prompted for the distance from the
selected vertex to the point to be digitised.  Enter the
distance, you will then be prompted for the second
vertex.

Select the second vertex, you will then be prompted
for the second distance.
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Enter the distance from the second vertex to the
point to be digitised.  The initial point to be digitised
will be marked with a circle cross and the confirm /
flip dialog will appear.

Press Confirm  if the displayed position is correct, or
press Flip  if the displayed position is on the wrong
side of the selected vertices.  The new point will then
be created.

Parallel Offset

The Parallel Offset function will generate new points
which are parallel to an existing feature.  You can
use this function with the Geometry and Capture
tools on conjunction with line and area features.
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To use this function first select Parallel Offset  from
the current tools function menu.

The following caption will appear at the top of the
map display area:

Select the feature you wish to generate the parallel
line from, tapping at the position you want the
parallel line to start from.  The existing feature will
be highlighted and the start point marked with a
circle cross.
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The prompt will have changed to ask you to tap on
the point on the existing feature where the parallel
line should end.  You will then be asked to enter the
offset distance between the existing feature and the
new parallel line.

Enter the distance between the existing feature and
the new parallel line and press Enter .

The offset is made to the “right” of the feature, if
you want the offset to be to the “left” then enter a
negative offset.  The provisional parallel line will be
displayed together with a dialog which allows you to
accept the parallel line or flip it to the other side of
the existing feature.

On completion the new points of the parallel line
will be added to the current capture feature.
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Enter Point

The Enter Point function allows you to enter a new
or changed point by typing the coordinate.

To use this function first select Enter Point  from the
current tool’s function menu.  You will be prompted
for the coordinate values.

If you are capturing a feature, a new point will be
added to the current feature.  If you are modifying
an existing feature in the Geometry Tool then the
current edit point will be moved (or inserted) using
the supplied coordinate.

The Selection List

When using the Identify, Area, Attributes and
Geometry tools you can choose to see a list of
features found within the search tolerance.  To
enable the selection list tick the “Show list when
several features found” box in the Map Tools page of
the PocketGIS Options sheet.  By default the selection
list is disabled.

When the selection list is enabled, and more than
one feature is found within tolerance of a screen tap,
a list of the features is displayed.
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Tap the feature that you want to work with and
press the Select button (or double tap the feature).
You can identify the features in the list by tapping
them and pressing the Highlight button.  On most
Handheld PC machines the selection list remains
visible during the highlight.  The list will have been
positioned to avoid the original tap point but if it is
still in the way you can drag it around the screen
using the title bar.  On Palm-sized and Pocket PC
machines, and Handheld PC’s with very small
screens, the selection list will be hidden for two
seconds while the feature is highlighted.

If the selection list is disabled the nearest feature to
the tap is selected automatically with point and text
features given precedence over line features.
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Map Tools Options

There are a group of options that can be used to
configure the Map Tools.  These options are accessed
via the PocketGIS menu on the main menu bar.

To open the PocketGIS options, tap the PocketGIS
menu and select Options .

The Options Dialog will be displayed, tap on the
“Map Tools’ tab to reveal the Map Tools Options.

Note: if you have a customised version of PocketGIS
the Map Tools options may not be available.
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Search Tolerance

This option sets the distance from the tap point that
PocketGIS will search when selecting features.  This
tolerance is also used when searching for a feature
to snap to.

Tap on the Search Tolerance  popup to change the
current setting.

Snap Default

This option sets the default state of the Snap control
in the Geometry and Capture tools.
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Off - means that snapping will be off when you first
open the Geometry or Capture tool.

On - means that snapping will be on when you first
open the tool.

Last - means that snapping will be on or off
depending on the state in which you last left the
Snap control.

Show list when several features found

Tick this box to show the selection list, as described
earlier in this chapter.  The selection list allows you
to choose from features within tolerance when
tapping on the screen.  By default the selection list is
disabled.
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Chapter 5

Navigation & Display
Tools

This chapter explains how to use tools which enable
you to navigate around the map display.

These tools enable you to:

• Zoom / Pan to a grid reference.

• Zoom / Pan to an OS sheet reference.

• Manually set the display scale.

• Find features by attribute value.

• Redraw the screen.

• Save & return to named display extents.

The Navigation & Display Tools Button

The Navigation & Display Tools Button is located at
the right hand side of the main toolbar.
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Tapping the Navigation & Display Tools Button
displays the Navigation & Display Tools MenuNavigation & Display Tools MenuNavigation & Display Tools MenuNavigation & Display Tools MenuNavigation & Display Tools Menu
which provides a list of the tools available at the
current time.

You will find that not all the tools are always
available.  Tools will only be enabled in the menu
when the current state of the View would allow them
to be used.

If you have an enhanced or customised version of
PocketGIS you may find that the list of tools is
different to that described here.  Refer to
supplementary documentation for information on
Navigation & Display Tool Enhancements.

Grid Reference Tool

This tool will zoom / pan the display to a grid
reference which you enter in a dialog.  The map
display will change to show the chosen reference in
the centre of the display.
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Select Grid Ref  from the Navigation Menu - the Go To
Grid Reference dialog will appear.

Enter the Easting (X) and Northing (Y) coordinate of
the location you wish to pan to.  The values are
expressed in the current display units.  You can
optionally supply a scale in which case the display
will zoom as well as pan.  The scale defaults to the
current display scale.

Tap on the Go To  or OK buttons to change the
display.  Tapping the Close button will close the
dialog without changing the display.

If the grid reference you supply is near or outside
the edge of the current View extent the chosen
location will not appear in the exact centre of the
display.  A message will appear to inform you when
this happens.
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Sheet Reference Tool

This tool will zoom / pan the display to an Ordnance
Survey (GB) sheet reference which you enter in a
dialog.  The map display will change to show the
chosen reference in the centre of the display.

Note:  This option only appears if the Home City
specified in the World Clock Control Panel is in the
UK. Refer to the manual that came with your
Windows CE Device for information on how to do
this.

Select Sheet Ref  from the Navigation Menu - the Go
To Sheet Reference dialog will appear.

Enter the OS Sheet Reference of the location you
wish to pan to.  You can optionally supply a scale in
which case the display will zoom as well as pan.  The
scale defaults to the current display scale.

Tap on the Go To  button to change the display.
Tapping the Close button will close the dialog
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without changing the display.

If the sheet reference you supply is near or outside
the edge of the current View extent the chosen
location will not appear in the exact centre of the
display.  A message will appear to inform you when
this happens.

Set Scale Tool

This tool will change the current display scale.  The
location shown in the centre of the display will not
change.

Select Set Scale  from the Navigation Menu - the Set
Scale dialog will appear.

Enter the new scale value.

Tap on the Set Scale  button to change the display.
Tapping the Close button will close the dialog
without changing the display.

The scale at which the map display redraws may not
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be exactly the scale you have chosen.  The scale may
change slightly due to screen / data resolution
issues.

Redraw Tool

This tool will cause the map display area to redraw.
The scale and extent of the display will not change.

No dialogs are displayed by this tool - the action
occurs immediately.

This tool is useful as the display can get dirty with
stray pixels after lengthy data capture /
modification operations.

Find by Attribute Tool

This tool can be used to locate features by the value
of one of their attributes, or to list all features of a
given type.

Select Find by Attribute  from the Navigation Menu -
the Find by Attribute dialog will appear.
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The Layer popup allows you to select from each of
the layers in the current view.

The Feature popup list all the features in the chosen
layer.

The Attributes popup lists all the visible attributes of
the chosen feature.  If the feature does not have any
visible attributes this item will be disabled.

If there are visible attributes the Value item is used to
specify that you wish to find features with that
attribute value.  If you do not specify a value then
all features of the chosen type will be found.

Press the Find button to search for the required
features.  While searching a progress window is
displayed which allows you to cancel the find
operation.

If any features are found the Find Results window is
displayed.  This lists all features which matched the
search criteria giving their easting, northing, and the
value of the attribute chosen in the Find by Attribute
Value dialog (if any).  The features wll be
automatically sorted on the attribute value (if
present).
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If you select a feature you can:

Press Attributes to bring up the attributes form for
that feature.

Press Geometry to switch to the Geometry Map Tool
without changing the current map display.  If the
feature is from a read only layer the Geometry
button will be disabled.

Press Geom & Go to pan to the map display to the
feature and switch to the Geometry Map Tool.  If the
feature is from a read only layer the Geom & Go
button will be disabled.

Press Go To to pan the map display to the feature
and switch to the Identify Map Tool which will
highlight the feature.

If the GPS Navigation component is installed the
Find Results window also includes a Navigate To
button.

Pressing the Navigate To  button sets the GPS
Navigation function to navigate to the selected
feature.  See Chapter 11 for more information on the
GPS Navigation component.
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Save Extent Tool

This tool will save the current View display area as a
Named Extent.  This allows you to return to the area
displayed without having to “find” it again.

Select Save Extent  from the Navigation Menu - the
Save Display Extent dialog will appear.

Enter the name you wish to give the named extent.
The name must be unique.  If you enter a name that
already exists then a message will appear asking if
you wish to overwrite the existing extent of that
name.

Tap on the Save button to save the extent.  Tapping
the Close button will close the dialog without saving
the extent.

You will always be able to return to the saved extent
using the Named Extents Tool.
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Named Extents Tool

This tool will display a dialog listing the extents
which you have previously saved for the current
View using the Save Extent tool.  You can change the
map display to an extent from the list.  This tool will
only be available if you have at least one saved
extent.

Select Named Extents  from the Navigation Menu - the
Named Display Extents dialog will appear.

Select the extent you wish to display and tap the
Display  button (or double tap the name).  The map
display will change to the selected extent.  Tapping
the Close button will close the dialog without
changing the display.

Tapping the Delete  button will remove the selected
extent from the list.
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Chapter 6

General Tools

This chapter explains how to use general utility
tools.

These tools enable you to:

• Delete Maps which are loaded into PocketGIS.

• Create a simple map.

• Create a grid.

• Log data to a file.

• Connect to peripheral devices.

The peripheral tools are not described here.  Refer to
later chapters or supplementary documentation.

The General Tools Menu

The Tools Menu is located on the main menu bar.
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If you have an enhanced or customised version of
PocketGIS you may find that the list of tools is
different to that described here.  Refer to
supplementary documentation for information on
General Tool Enhancements.

Map Manager

This tool can be used to list and delete the Maps that
are loaded into PocketGIS.

Select Map Manager  from the General Tools Menu -
the Map Manager dialog will appear.

To delete a map, select it in the list and tap the
Delete  button.  A confirmation message will appear
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before the Map is deleted.

If you download a new version of a map that is
already stored in PocketGIS the old version is
automatically deleted.

Create Simple Map

The Create Simple Map tool provides a function
which can create a new, empty, map with a single
feature.  Simple Map features do not have attributes.
This allows you to create add-hoc geometry which
may be useful when using GPS or a laser
rangefinder.

The Create Simple Map  option can be found on the
Tools->Create sub menu.

Selecting will bring up the following dialog.

The Type  item lets you choose the type of the feature
in the simple map.  Possible options are Point, Line,
and Area.

The Location  item allows you to create the map in
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the devices Main Memory or a storage card if you
have one installed.

The Units  item lets you specify the units that the
coordinate data will be stored in.  A likely choice is
centimetres.  Note that PocketGIS stores points in
integral units (i.e. whole numbers) so if you, say,
chose meters then all points would be stored to the
nearest meter.  You can use the PocketGIS options to
display values in any units irrespective of the map
data units.

The Cancel  button quits the dialog.

When you have made your choices press Next  to
proceed to the next dialog.

Use the Name item to give the map a name.  This
name must be unique.

Use the Min X , Max X, Min Y, Max Y items to specify the
coordinate bounds of the map.  Note that the units
here are the current PocketGIS display units, not the
map units selected in the first screen.   (See Chapter
7 for more information on the display units setting
of PocketGIS).

The Back  button will return you to the first dialog.

Press the Create button to create the new map.  The
map’s layer will be added to the current view
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automatically.  If there is not a current view then
one will be created.

Create Grid

The Create Grid tool provides a function which can
generate a map grid within an existing map.

The Create Grid  option can be found on the Tools-
>Create sub menu.

Selecting will bring up the following dialog.

The Map, Layer , and Feature  items allow you to select
the map feature for which the grid lines will be
generated.  You need to create the map and feature
for the grid before you use the Create Grid function.
You can create the map in PocketGIS Connection or
by using the Create Simple Map function.  The grid
lines can only be created for line or area features
and so the Feature  popup list will only list line or
area feature types.  If the selected map layer does
not contain any line or area features then the
feature list will be empty.
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The Cancel  button quits the dialog.

When you have made your choices press Next  to
proceed to the next dialog.

Use the Min X , Max X, Min Y, Max Y items to specify the
coordinate bounds of the grid.  Note that the units
here are the current PocketGIS display units.   (See
Chapter 7 for more information on the display units
setting of PocketGIS).  These fields will be
automatically filled in with the maximum extent of
the selected map.  The grid cannot extent outside
the map extent.

Use the Interval  item to specify the interval of the
grid.

The Back  button will return you to the first dialog.

Press the Create button to create then new grid.

If you selected a line feature then the grid will be
formed from straight lines.  If you selected an area
feature then the grid will be made up of square area
features.
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Setting up a System of Scale Dependent Grids

You may wish to set up a system of grids which
appear at different scales.  For example, you may
want a 1Km grid to display at 1:5000 and a 10Km
grid to display at 1:25000.

You can achieve this by defining an appropriate
Translation Scheme in PocketGIS Connection (see the
PocketGIS Connection User Manual for information
on how to setup Translation Schemes and generating
empty maps).  The Translation Scheme can be set up
with features for the 1Km and 10Km grids.  A
Display Scheme can be created and setup so the
small scale grid does not display at larger scales and
correspondingly the large scale grid does not display
at small scales.  A legend could be created so the
grid lines appear in different colours.  The PocketGIS
Connection New Map will generate a map in
PocketGIS - you can use the Create Grid function to
generate the grid lines for the 1Km and 10Km grid
features.

Log to File

The Log to File function will save any data received
via a serial connection to a file. It can be accessed
from the Tools->LoggingTools->LoggingTools->LoggingTools->LoggingTools->Logging menu.
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The Connect ToConnect ToConnect ToConnect ToConnect To item allows you to select the serial
port the data is to be received on.

The Fi leFi leFi leFi leFi le item shows the file that the data will be
stored to. Data is appended to an existing file. The
file can be changed using the BrowseBrowseBrowseBrowseBrowse button.

The OptionsOptionsOptionsOptionsOptions button displays the port setting
options.

The ConnectConnectConnectConnectConnect / DisconnectDisconnectDisconnectDisconnectDisconnect button opens the
connection to the serial port and starts saving data
to the file; or disconnects from the port and closes
the file.

Data is saved exactly as it is received with no
processing.

Log to Feature

Log to Feature allows you to automatically create
point features and set attribute values from external
data sources such as sensor equipment.  The
position of the feature is taken from the current GPS
position so a GPS receiver must be connected and be
providing an acceptable position.

Two items are provided on the Tools->LoggingTools->LoggingTools->LoggingTools->LoggingTools->Logging
menu to control logging to features:
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Logging DeviceLogging DeviceLogging DeviceLogging DeviceLogging Device allows you set select which
external device you are using and the port and
connection parameters.  You need to make these
settings the first time you use a logging device or
when you change which type of device is being used.
You can also use this to connect and disconnect the
device.  To save all settings press the ConnectConnectConnectConnectConnect
button to establish the connection to the device.
Once the current settings are saved the device will
be connected automatically when you press the Log
to Feature StartStartStartStartStart button (see below) so you don’t
need to manually connect the device each time you
start logging.
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Log Data to FeatureLog Data to FeatureLog Data to FeatureLog Data to FeatureLog Data to Feature allows you to select the
feature that will be created by the logging.  Only
layers / features in the current View are displayed.
Pressing the Start Start Start Start Start button will commence logging.
Each log reading from the external device will create
one feature (adjust the device to control the
frequency of feature creation).  The system
“acknowledge” beep will sound for each successful
feature, if there is a problem (e.g. storage full, no
GPS position) then the system error beep will sound
for each reading.  If logging is in progress the button
will become Stop Stop Stop Stop Stop and you can use this to stop
logging.  Logging will also stop if the logging device
is disconnected.

Log to Feature controls also appear on the Devices
menu of the various map tools.  The items are
similar to those accessed from the Tools menu when
the device is not connected, or logging is not started,
but act as quick action functions when logging is in
progress.  So Connect Logging Device becomes
Disconnect Logging Device which disconnects the
device and stops logging without showing a dialog
window.  Likewise Log Data to Feature becomes Stop
Log Data to Feature.

Data from the external reading is automatically
assigned to the features attributes base on the
Internal Name of the attribute.  Any auto set
attributes are also assigned.  If a given attribute is
missing that data will not be logged.  Attributes are
as follows:

Radiodetection RD4000

The depth value is assigned to an attribute whose
internal name is Depth.



7-1

Chapter 7

Options

This chapter explains how to set options which
configure PocketGIS.

There are 5 groups of options:

• General.

• Map Tools.

• Input Panel.

• Backup.

• Image Capture.

The Map Tools Options are described in Chapter 4 -
Map Tools.  Backup options are descrbed in Chapter
1 - Installaton and Setup.

The Options Dialog

The Options Dialog is accessed from the PocketGIS
Menu.
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Tap on Options  to display the Options Dialog.

You can enter an options group by tapping on it’s
tab.

If you have an enhanced or customised version of
PocketGIS you may find that the list of options is
different to that described here.  Refer to
supplementary documentation for information on
Options Enhancements.

General Options

Tap on General  to display the General Options.

Display Units

This defines the units in which you want
measurements to be displayed.  This option also
defines the units in which grid references are
specified.

You can change the value using the popup list.  The
default is meters.
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Metric Conversion

This option determines the factor used to convert
between metric and imperial (miles, feet, inches)
units.  The international standard for such
conversion is 1 inch = 2.54 centimetres.  However,
usage in the United States is commonly 1 metre =
39.37 inches.  Although the difference between these
factors is small it does make a difference when
calculating coordinates and it is important that the
correct setting is chosen.

If you are working in metric units for both map
storage and display, or entirely in imperial units,
then no metric / imperial conversion will take place
and this setting will not be used.

Note that this setting only applies to conversions
within the PocketGIS main application and can be
applied when freehand digitising or displaying
coordinates, distances, areas etc.  The unit
conversion for calculating GPS positions in feet is set
from within the GPS Receiver options.  The Laser
Rangefinder module does not have a conversion
factor setting and you should configure your laser
measurement device to work in metric or imperial
units depending on which is used to represent your
data.

Single View Mode

If this checkbox is ticked PocketGIS operates in
Single View Mode.  Unticking this box will switch the
application into Multiple View Mode which is
described in chapter 8.
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Map Tools

These options are described in Chapter 4.

Input Panel

Tap on Input Panel  to display the Input Panel
Options.

This allows you to control if the input panel is
automatically displayed when dialog windows
requiring text input are shown.

If Show input panel automatically  is ticked the input
panel will automatically appear, when required, for
dialog windows other than the attributes form.  If
unticked the input panel will not be shown and you
will have to display it manually using the keyboard
button on the menubar (Pocket PC) or the taskbar
(Palm-sized PC) or in the system tray (Handheld PC)
- the tray is the area next to the clock on the
Taskbar.

If Show input panel for attributes form  is ticked the
input panel will automatically appear, if the are type
input attributes, when the attributes form is
displayed.  If unticked the input panel will not be
shown.  You can manually show the input panel
using the on screen keyboard button.
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By default, software keyboards appear when needed
on Pocket PC devices.  By default they are turned off
on other devices.  Note that a software keyboard is
not available on all devices.

Backup

These options are described in Chapter 1.

Image Capture

The image capture functionality allows options to be
set which to automatically control third party
camera software and acquire images stored directly
to a devices storage memory. These options work in
conjunction with the Image Selector window which is
displayed when the ImageImageImageImageImage button is pressed on the
attributes form - see the “Image Attributes and the
Image Selector / Browser” section of Chapter 4 of the
PocketGIS manual for details.

To set the image capture options select OptionsOptionsOptionsOptionsOptions
from the PocketGISPocketGISPocketGISPocketGISPocketGIS menu; then go to the ImageImageImageImageImage
CaptureCaptureCaptureCaptureCapture page.
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The Camera ProgramCamera ProgramCamera ProgramCamera ProgramCamera Program item allows you to select an
application which is launched when the TakeTakeTakeTakeTake
PicturePicturePicturePicturePicture button is pressed on the Image Selector
window. Select the third party program which
controls and takes pictures using your camera.

The Image FolderImage FolderImage FolderImage FolderImage Folder item allows you to specify the
folder which the camera application, or other image
transfer mechanism (e.g. Bluetooth OBEX) , stores
images. When the Image Selector window is open
any new image appearing in this folder will be
automatically selected into the Image Selector
window as the current image.

Once these settings have been configured the TakeTakeTakeTakeTake
Picture Picture Picture Picture Picture button will launch the nominated
application allowing you to take a picture. When
that picture is stored to the image folder PocketGIS
will select the image and return to the foreground.
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Chapter 8

Multiple View Mode

This chapter describes how to use PocketGIS in
“Multiple View Mode”.

By default, PocketGIS operates in Multiple View
Mode.   This mode is useful if you are working with
different sets of map data which you want to access
separately.  Map Views are explained in Chapter 3.

You may wish to switch the application into Single
View Mode which will simplify the View menu by
removing the items related to multiple views.

As the relationship between a Map Layer, Legend,
and Display Scheme is maintained in a View, you can
also use this mode to access the same map data
using different Legends & Display Schemes.

Enabling Multiple View Mode

To enable Multiple View Mode, first select Options
from the PocketGIS menu to open the Options dialog.
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Uncheck the Single View Mode  checkbox.

Close the Options dialog.  A number of additions will
have been made to the View menu.

Select

This menu item can be used to switch between
different Map Views - the current View is marked.
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New

Selecting New will open the New View dialog.  This
operates in exactly the same way as the Modify View
dialog described in Chapter 3 and can be used to
manually create a Map View.

Delete

This item enables you to delete the current Map
View.  You will be asked to confirm before anything
happens.
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Chapter 9

GPS Receiver

This chapter explains how to connect a GPS receiver
to PocketGIS.

The GPS Receiver component will work with external
GPS receivers supporting the NMEA protocol
connected via a serial port or card slot.

The GPS connection is controlled from the GPS
Receiver dialog which is accessed via the General
Tools Menu.

Selecting GPS Receiver  will display the GPS Receiver
dialog.
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Height Data

Note that heights displayed and stored by PocketGIS
are ellipsoid heights, with the exception of OSGB and
Danish coordinates.

UK GPS

If the map projection is set to “OS Great Britain” GPS
coordinates will be shifted according to the OSTN02
model.  Also note that for OSGB, heights are
corrected to the OSGM02 model.

Danish Projections

Use of the Danish projections requires the
installation of the Danish Datum Tables from the
main installer.

Supported NMEA Position messages

GPS Receiver can receive position information from
the NMEA GGA, GLL, GGQ and GST sentences.
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Only use GGL if your receiver does not support GGA
or GGQ. If GGQ or GGA sentences are being received
then GLL sentences will be ignored. Note that GLL
sentences do not supply data quality or height
information and this will not be displayed, stored, or
filtered on.

You can choose to use either, or both, the GGA and
GGQ sentences. The GGA sentence does not provide
coordinate quality values, and GGQ does not provide
HDOP values. Otherwise they are the same. If you
want access to both HDOP and coordinate quality
then set your receiver to output both of these. Note
that presently, GGQ sentence support is fairly rare.

The Omnistar OMNIPOSA message is supported so
position standard deviation values can be received.
This message can be used in conjunction with GGA
and / or GGQ messages if HDOP and coordinate
quality values are required.

For best results set the NMEA sentences to output at
least once per second. Any less than this and GPS
Receiver will report “No GPS Input” regularly. The
timeout is deliberately tight to ensure that the GPS
position used by PocketGIS is correct.

Windows Mobile GPS Program Port

PocketGIS can connect to a GPS Receiver controlled
by the GPS Settings panel in Windows Mobile 5 and
later.
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To enable this follow the Windows Mobile
documentation and ensure that the GPS Program
Port is a COM port (do not select a GPD port).  Once
enabled this COM  port can be selected as the GPS
port in PocketGIS.

Unless you need the GPS location data to be used in
more than one application at once there is no
benefit in using the Windows Mobile GPS Program
Port.  It is recommended that “Manage GPS
automatically” is unticked in the Access page of
Windows Mobile GPS Settings and that you connect
to the GPS device or port directly.

Recommended Port Speed

If the receiver is only configured to output NMEA
GGA or GGL sentences then a port speed of 9600 bps
should be sufficient. If the receiver is configured to
output many messages or a combination of GGA,
GGQ or manufacturer specific messages then it is
recommended that you use the fastest speed
available. If PocketGIS appears to be dropping
information (e.g. HDOP or coordinate quality) then
this can be due to the data not being received
quickly enough. PocketGIS deliberately puts a very
tight limits on the frequency that messages must be
received to ensure that the data is current and
accurate.

GPS Protocols

The GPS Receiver component currently supports
‘NMEA’, ‘Ashtech NMEA’ and OmniSTAR HP
protocols. The Ashtech protocol includes standard
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NMEA support and also provides Ashtech specific
modem dialup functionality. If you need protocol
support which is not currently provided please
contact support@pocketgis.com.

Position Standard Deviation Support

If available from the receiver, position standard
deviation values in metres are displayed by the GPS
monitor. You can also filter on these.

Setting Up GPS Receiver

Before you can use GPS Receiver you must set all the
configuration options.  If you try and connect to a
GPS Receiver without visiting each options page you
will be prompted to check any remaining options.
When you visit an options page default settings will
be shown - you can accept these defaults without
making any changes - just move to the next page or
press OK.

To ensure that the projected coordinates which are
displayed and stored by PocketGIS are accurate, you
should carefully check how the GPS Receiver options
are configured.  In particular make sure that the
“Convert” options are set correctly.  It is advisable
for you to check that positions reported by
PocketGIS are consistent with your expectation and /
or known positions.
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It is essential that you carefully check thatIt is essential that you carefully check thatIt is essential that you carefully check thatIt is essential that you carefully check thatIt is essential that you carefully check that
the GPS Receiver component is correctlythe GPS Receiver component is correctlythe GPS Receiver component is correctlythe GPS Receiver component is correctlythe GPS Receiver component is correctly
configured.  Failure to do so can result inconfigured.  Failure to do so can result inconfigured.  Failure to do so can result inconfigured.  Failure to do so can result inconfigured.  Failure to do so can result in
inaccurate results.  The responsibility forinaccurate results.  The responsibility forinaccurate results.  The responsibility forinaccurate results.  The responsibility forinaccurate results.  The responsibility for
ensuring that the GPS position is correctensuring that the GPS position is correctensuring that the GPS position is correctensuring that the GPS position is correctensuring that the GPS position is correct
rests entirely with the user.rests entirely with the user.rests entirely with the user.rests entirely with the user.rests entirely with the user.

Bring up the GPS Options dialog by pressing the
Options  button on the GPS Receiver dialog.

Display Options

This group of options controls how the GPS position
is reported on screen.

Display GPS Coordinate

If this box is checked the GPS position, in the
selected coordinate system and projection, will be
displayed in a box in the bottom left hand corner of
the screen.
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Display GPS Height

If this box is checked the height reported by the GPS
receiver will be displayed with the coordinate.  The
value is the sum of the antenna height and the
geoidal separation, as modified by the datum
conversion algorithm (if any is in force).

Map display follows GPS Position

If this box is checked the map display will
automatically pan to keep the current GPS position
in view.

Display original geographic coordinated

If this box is checked the latitude & longitude of the
current position, as output by the GPS receiver, will
be displayed in the bottom left hand corner of the
screen.

Display converted geographic coordinates

If this box is checked the latitude & longitude of the
current position, as modified by the current datum
conversion algorithm, will be displayed in the
bottom left hand corner of the screen.  If no datum
conversion is enabled then these values will be the
same as those output by the GPS receiver.  If both
this box and the “Display original geographic
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coordinates” are checked, then the original
coordinates will be displayed first, followed by the
converted values.

Port Options

This group of options allows you to setup the
communications port for use with the GPS receiver.
You need to consult the manual that came with your
GPS receiver in order to determine the correct
option values.  The settings of both the receiver and
PocketGIS must match exactly.

Speed

Set the speed, in bits per second, to the speed that
your GPS receiver outputs data.

If the receiver is only configured to output NMEA
GGA or GGL sentences then a port speed of 9600 bps
should be sufficient.  If the receiver is configured to
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output many messages or a combination of GGA,
GGQ or manufacturer specific messages then it is
recommended that you use the fastest speed
available.  If PocketGIS appears to be dropping
information then this can be due to the data not
being received quickly enough.  PocketGIS
deliberately puts a very tight limits on the frequency
that messages must be received to ensure that the
data is current and accurate.

Settings

Set this to the character format that your GPS
receiver uses to output data.  The options show:
number of data bits / parity / number of stop bits.

Projection Options

This page lets you specify the map projection that
the geodetic coordinate output from the GPS
receiver are translated to.  This must be the same
projection as the map data you are using.



9-10

PocketGIS User Manual

Projection

Select the map projection that you are using.  You
can choose between Universal Transverse Mercator
(UTM) and a number of national projections
including the Ordnance Survey (OS) projection.

Note that some projections require that datum tables
are installed.  You will be warned if you select a
projection that requires tables that are not present.
Any such datum tables will be shown in the product
installer when you choose a custom installation or
the modify option - see Chapter 1.

Datum

For many projections this simply displays the
geodetic datum used by the selected projection.  For
some projections, such as UTM, this item allows you
to specify which datum should be used.

It is very important that you select theIt is very important that you select theIt is very important that you select theIt is very important that you select theIt is very important that you select the
projection and datum that correspond to theprojection and datum that correspond to theprojection and datum that correspond to theprojection and datum that correspond to theprojection and datum that correspond to the
data you are using with PocketGIS.data you are using with PocketGIS.data you are using with PocketGIS.data you are using with PocketGIS.data you are using with PocketGIS.
Inaccurate results will be obtained if theseInaccurate results will be obtained if theseInaccurate results will be obtained if theseInaccurate results will be obtained if theseInaccurate results will be obtained if these
settings are not correct.settings are not correct.settings are not correct.settings are not correct.settings are not correct.

Units

This item specifies the distance units generated by
the projection algorithm.  For most projections this
will be preset to the correct value and you will not
be able to change it.  For some projections, such as
UTM, you can select the units.
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The choices are Metres, International Feet, and US
Feet. The difference between International and US
Feet is the factor used to convert from metres (in
which the calculation is performed) and feet.
International Feet uses the factor 1 inch = 2.54cm
and US Feet uses 1 metre = 39.37 inches.  Although
the difference between these factors is small it does
make a difference and it is important that the
correct setting is used.

Convert Options

Your GPS receiver will output position data in a
particular datum.  If this datum is the same as the
one you have selected in the Map Projection page
then PocketGIS can use the GPS data directly.
However, if the datum output by the receiver is
different to the one used by the PocketGIS map
projection, you must configure the Convert Datum
settings so PocketGIS can make the necessary
adjustments.

It is important that you consult the manual that
came with your GPS receiver very carefully.  Some
GPS receivers only output data in the WGS-84
datum.  Other receivers will output in a datum of
your choice.  If the receiver has controls which allow
you to choose a datum for coordinates on the
receiver’s own display - you should check to see if
the receiver also outputs data using this datum (THE
DISPLAY AND OUTPUT DATUMS MAY BE
DIFFERENT!).

It is very important that you set the DatumIt is very important that you set the DatumIt is very important that you set the DatumIt is very important that you set the DatumIt is very important that you set the Datum
Conversion options correctly.  InaccurateConversion options correctly.  InaccurateConversion options correctly.  InaccurateConversion options correctly.  InaccurateConversion options correctly.  Inaccurate
results will be obtained if these settings areresults will be obtained if these settings areresults will be obtained if these settings areresults will be obtained if these settings areresults will be obtained if these settings are
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not correct. not correct. not correct. not correct. not correct.  Also note that the datumAlso note that the datumAlso note that the datumAlso note that the datumAlso note that the datum
conversions in the PocketGIS software areconversions in the PocketGIS software areconversions in the PocketGIS software areconversions in the PocketGIS software areconversions in the PocketGIS software are
“mean” shifts.  If you are using differential“mean” shifts.  If you are using differential“mean” shifts.  If you are using differential“mean” shifts.  If you are using differential“mean” shifts.  If you are using differential
GPS for accurate positioning, and relying onGPS for accurate positioning, and relying onGPS for accurate positioning, and relying onGPS for accurate positioning, and relying onGPS for accurate positioning, and relying on
PocketGIS for datum conversion, you shouldPocketGIS for datum conversion, you shouldPocketGIS for datum conversion, you shouldPocketGIS for datum conversion, you shouldPocketGIS for datum conversion, you should
contact Pocket Systems or your supplier tocontact Pocket Systems or your supplier tocontact Pocket Systems or your supplier tocontact Pocket Systems or your supplier tocontact Pocket Systems or your supplier to
discuss localised datum shifts.discuss localised datum shifts.discuss localised datum shifts.discuss localised datum shifts.discuss localised datum shifts.

Use the Input Datum  popup to specify whether the
data input to PocketGIS from the GPS receiver is in
the same datum as the Map Projection, or whether
the datum will need to be converted.  The Input
Datum item specifies the datum that the GPS receiver
is using.  This is the datum that the GPSThis is the datum that the GPSThis is the datum that the GPSThis is the datum that the GPSThis is the datum that the GPS
receiver is using to output data, not thereceiver is using to output data, not thereceiver is using to output data, not thereceiver is using to output data, not thereceiver is using to output data, not the
datum you wish to use in PocketGIS.datum you wish to use in PocketGIS.datum you wish to use in PocketGIS.datum you wish to use in PocketGIS.datum you wish to use in PocketGIS.

The possible values for Input Datum are dependent
on the datum of the current projection (the T oT oT oT oT o
item).  Possible options are the datum of the map
projection, and one or more WGS84 based option.

‘WGS84 - ITRS 2000 (now)’ indicates that the input
position will be corrected for continental drift.  If
this is not available for the selected projection
datum the option ‘World Geodetic System 1984’ is
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given.  This indicates that a WGS84 (or indeed ITRS)
position is expected but that no compensation for
continental drift is included.

The ViaViaViaViaVia item specifies whether an initial datum
conversion is to be applied.  At present this is only
available for correcting the input position to ITRS 89
/ ETRS 89 before the position is transformed to the
datum selected on the Projection options page.

Sometimes datum conversion takes place via an
intermediary datum such as ETRS89.  If this is the
case the intermediary datum can be selected as the
Input Datum.  So, for example, if an ETRS89 position
was being supplied to PocketGIS by equipment that
performs this transformation  (or comes from a
correction service that provides ITRS 89 / ETRS 89),
and outputs positions in ITRS 89 / ETRS 89 you
would choose ‘European TRS 1989’ as the input
datum.  ie.  The software will not perform the
correction because it has already been applied.
Conversely if a WGS84 / ITRS2000 position were
being supplied you would select ‘WGS84 - ITRS 2000
(now)’ as the input datum - ETRS89 would become
the Via datum as PocketGIS would do the conversion.

If the position is being received from equipment that
outputs a ‘current’ WGS 84 - ITRS 2000 (now)
position then the Input Datum Input Datum Input Datum Input Datum Input Datum item of the
ConvertConvertConvertConvertConvert page should be set to ‘WGS-84 - ITRS 2000
(now)’.

If you are using a low accuracy (e.g.. 10m) GPS
receiver then select ‘WGS-84 - ITRS 2000 (now)’.  In
this case the ViaViaViaViaVia setting does not matter as the
difference will be tiny compared to the overall
accuracy of the position.
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The GPS Receiver component has preprogrammed
values for datum transformations from WGS84 to
the datum of the selected coordinate system.
However you may, if you wish, specify custom
values.  If you do you should ensure that the values
are correct, the responsibility for ensuring this is
100% yours.

If the input datum differs from the T oT oT oT oT o datum then
the Parameters  button will be enabled and pressing it
displayed the Transformation Parameters window.

By default the parameters are set to use the
preprogrammed values in the GPS receiver module
and it is these values that are displayed.  If you wish
to use your own parameters untick the “Use
standard values” box and type in the required
values.  Press OK to save your new parameters and
be sure to press OK on the main options window to
save your changes.  To revert to the standard
parameter values open the Transformation
Parameters window and tick “Use standard values”.
If you change the current coordinate system or
datum then the user defined values will be
disregarded and the relevant preset values used -
until you return to the Transformation Parameters
window and reinstate any preferred parameters.
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If a Via datum is enabled, the user transformation
parameters are applied after the via transformation.

Note that user supplied values are for a 7 parameter
Helmert transformation NOT a Molodensky
transformation.  The displayed preset values are for
7 parameter Helmert transformations or, where only
delta X,Y,Z is specified, for a Molodensky
transformation.

Note also that datum transformations are unrelated
to local shift, and that local shift is unrelated to
datum transformations.  Local shift is an eastings
and northings delta which is applied after
rectangular coordinates have been generated.

Monitor Options

The GPS monitor will, by various means, inform you
of the state and quality of the GPS position data
being received from the GPS receiver.
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Show GPS Monitor

If this box is checked then certain details of the GPS
position data will be displayed in the bottom left
hand corner of the map display area.

The following is displayed:

GPS Quality - whether a GPS position is being
received and, if so, whether it is GPS, DGPS
(differentially corrected), RTK, or HP (High
Precision).

HDOP - The Horizontal Dilution of Precision Value (if
available).

Qual - The coordinate quality value from the
receiver (if available).

The number of satellites used in the position
calculation.

If DGPS the age, in seconds, of the differential
correction.

If an High Precision (HP) receiver is attached and is
providing position standard deviation information
then the residual values for latitude, longitude and
height are displayed.
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Play warning sound when not receiving GPS Input

If this box is checked a warning sound will be played
whenever there is no input on the GPS port.  This
will warn you if, for example, the GPS cable becomes
detached.

Play warning sound if filter criteria are not met

If this box is checked a warning sound will be played
if the GPS position quality does not meet the filter
criteria specified in the filter options page.  The
filter options page is described below.

Log

Pressing the LogLogLogLogLog button displays the GPS Position
Log options.

GPS Position Log

GPS Position Log will keep a record of the current
GPS position in a plain text file on the local machine.
This file can be read by third party applications.

You must also ensure that the correct projection /
coordinate system is selected in the GPS Receiver
options.  The position cannot be logged unless there
is a live GPS connection which is receiving the
current GPS location.

Once installed this component adds a GPS PositionGPS PositionGPS PositionGPS PositionGPS Position
LogLogLogLogLog item to the PocketGIS Tools menu.  Select this
item to display the GPS Position Log Options window.
Note that any changes are only saved if you close
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the window with the OK button.  Pressing the close
button will not save the changes (note, there is no
close button on the Pocket PC version).  Changes will
not take effect until you press the OK button.

The options window has two pages.

The Logging Logging Logging Logging Logging page provides controls to configure
how the logging is performed.

Enable LoggingEnable LoggingEnable LoggingEnable LoggingEnable Logging turns the logging on and off.  Tick
this box to start logging, untick it to stop logging.

Interval Interval Interval Interval Interval allows you to choose how often the logging
file is rewritten with the updated position.

Coordinates Coordinates Coordinates Coordinates Coordinates allows you to select the format of the
coordinates that are written to the file:

“Source Geodetic” stores the latitude and
longitude, as output from the GPS receiver.

“Converted Geodetic” stores the latitude and
longitude after any datum conversion has been
preformed.

“Projected” stores rectangular coordinates in
the coordinate system selected in the GPS Receiver
component.
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Log TypeLog TypeLog TypeLog TypeLog Type allows you to select the type of log
generated:

“Last Position” just records the last position,
overwriting the last position recorded each time.

“Continuous” records the position at each
interval, providing a continuous log of the
position at each interval.

The File Fi le Fi le Fi le Fi le page provides the means to specify the file
to which the position will be logged.  Press the
Browse Browse Browse Browse Browse button to display the file select window to
change the logging file.

File Format - Last Position

The logging file is a plain text file which has the
following format:

For geodetic coordinates:

LA=57.148465
LO=-2.087690
WGS84=1

where LA is the latitude (+ve = north, -ve = south)
and LO is the longitude (+ve = east, -ve = west).

The WGS84 line has the following values:
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1 - datum is WGS84.
0 - datum is not WGS84.
-1 - GPS Position Log could not determine whether or
not the datum was WGS84 (see release notes).

For rectangular (projected coordinates):

East=394793.83
North=806402.72

where East is the easting, or X value; and North is the
Northing, or Y value.

Also included are the following values:

Date=10/04/01
Time=18:21:13
GPS=2

The date and time are in "short format" as
determined by the operating system's locale settings
panel.  The GPS item indicates the quality of the
source GPS position and has the following values:

0 - No GPS Position from receiver, GPS Receiver
component not receiving input, or GPS Receiver
component not connected.

1 - GPS Position.
2 - Differential GPS Position.
3 - RTK float GPS Position.
4 - RTK fixed GPS position

Note that when GPS=0 then the last known position
is recorded.
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File Format - Continuous

The continuous mode adds a line to the log at each
interval.  The fields are similar to ‘Last
Position’mode but appear in a line record format,
e.g.

8/21/02 10:05 AM- 57.148463,-2087687,0,2

Which is: date, time, latitude, longitude, WGS84 flag,
GPS quality

or

8/21/02 10:05 AM - 394793.83,806402.72,2

Which is easting, northing, GPS quality.

Filter Options

You can set filter options which define the minimum
GPS position quality that you will accept.  If the filter
criteria are not met then the GPS position is not
accepted by PocketGIS so you will not inadvertently
capture data from a poor quality position.

If the coordinates are being displayed (see Display
Options above) the position is shown in square
brackets if the filter criteria are not met.

If the filter warning sound is enabled (see Monitor
Options above) a warning sound is played when the
filter criteria are not met.
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Quality must be

If this box is checked then the GPS position will only
be valid if it meets the quality criteria selected in the
accompanying popup list.  The options are:

• Differential GPS (DGPS) or better

• Real Time Kinematic Float (RTKF) or better

• Real Time Kinematic Fixed (RTKX)

Maximum HDOP

If this box is checked then the GPS position is only
valid if the HDOP value is less than or equal to the
value specified in the adjacent field.

Maximum age of differential correction

If this box is checked then the GPS position is only
valid if the age of differential correction is less than
or equal to the value, in seconds, specified in the
adjacent field.
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Minimum number of satellites

If this box is checked then the GPS position is only
valid if the number of satellites is greater than or
equal to the number specified in the adjacent field.

Required coordinate quality

If this box is checked then the GPS position is only
valid if the receiver’s expected position accuracy is
better, or equal to, the value entered in the adjacent
field.  This value is given by the NMEA GGQ sentence
and is not available on all GPS receivers.

Filter 2 Options
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The second set of filter options allows you to filter
on position standard deviation when using receivers
(e.g.. High Precision) that provide this information.

Required position standard deviation

If this box is checked then the GPS position is only
valid if the receiver’s standard deviation values meet
the given limits.

Stop input when filter fails

When ticked, if the received position quality falls
below the filter criteria then a message box appears
and capture from GPS positions is suspended until
the user presses OK on the message box.  This is so
the user can verify the position accuracy when the
quality data provided from the GPS receiver is not
trusted.
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Antenna Height Options

The Antenna HeightAntenna HeightAntenna HeightAntenna HeightAntenna Height page in GPS Options enables
you to set a correction for the offset between the
antenna height and the current ground position.
This value is composed of antenna pole height (the
distance from the ground to the top of the antenna
pole) and thickness (the distance from the top of the
pole to the active point in the antenna).

When the Compensate for antenna heightCompensate for antenna heightCompensate for antenna heightCompensate for antenna heightCompensate for antenna height box is
ticked the Pole heightPole heightPole heightPole heightPole height and Antenna thicknessAntenna thicknessAntenna thicknessAntenna thicknessAntenna thickness
values are added together and subtracted from the
current GPS position height value.  When an antenna
height correction value is being applied the value
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appears in brackets after the corrected height values
in the GPS monitor display in the bottom left hand
corner of the screen.

Normally the Antenna Height and Geoidal
Separation values from the GPS position are added
together to make a height value.  If you need to
override the GPS height value unticking the AddAddAddAddAdd
Geoidal SeparationGeoidal SeparationGeoidal SeparationGeoidal SeparationGeoidal Separation box will derive a height using
just the GPS Antenna Height - (Antenna Pole Height
+ Antenna Thickness).

The GPS monitor window shows the height as
Antenna Height +  Geoidal Separation in the original
position reading and GPS Antenna Height - (Antenna
Pole Height + Antenna Thickness) in the converted
reading.

Normally the Add Geoidal SeparationAdd Geoidal SeparationAdd Geoidal SeparationAdd Geoidal SeparationAdd Geoidal Separation box should
be left ticked, even if you are using an Antenna
Height correction.

Average Options
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Normally the current position is calculated from a
single GPS reading.  In some circumstances it you
may want to calculate the current position by taking
the average of a number of successive readings.  To
enable average position calculation tick the Enable
position averaging  box and enter the number of
points you wish to be averaged.

Once enabled the current position will be calculated
by averaging the chosen number of points.  If you
have enabled the display of geographic coordinates
then the original geographic coordinate will be the
current reading from the GPS receiver and the
converted geographic coordinate will be the average
reading as modified by the datum conversion - if
one is in effect.  The number of points that have
been averaged is shown after the projected
coordinate as “~n” where n is number of points.  If
the number of points is less than that specified in
the “Average” options page the coordinate will be
shown in square brackets and you will not be able to
capture from GPS.

If you have specified filter criteria in the Filter
options page then points that do not meet the
criteria will not be included in the average
calculation.
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DGPS Dialup

Some GPS receivers allow a modem or mobile
telephone to be attached in order to receive
differential corrections.  You can set the GPS
Receiver component to instruct some GPS receivers
to dialup a differential server when the GPS
connection is established.  To do this, open the GPS
Receiver window and select a protocol that supports
DGPS dialup and then go into Options->DGPS Dialup.
Tick the Enable DGPS DialupEnable DGPS DialupEnable DGPS DialupEnable DGPS DialupEnable DGPS Dialup to turn this feature
on and specify the telephone number to dial.  You
will also need to specify the ports, on the GPS
receiver, that the modem, and the device running
PocketGIS, are connected to.

Once setup the number will be dialled when you
connect to the GPS receiver.  When you disconnect
the call will be ended.

Local Shift Options

These are described in the “Local Shift” section later
in this chapter.
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Connecting to a GPS Receiver

You can connect to an  GPS receiver which supports
the NMEA 0183 (V 2.0) protocol and can be
configured to output an NMEA ‘GGA’, ‘GGQ’  or ‘GLL’
sentence.

Connecting the Receiver

Before you connect the receiver ensure that the
various options are configured correctly.  The
settings will be saved so you only need to do this
once (unless of course you use a different receiver or
change it’s settings).
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If the current position is not available, the last
known position is marked with a slightly different
icon.

You can also connect to the GPS Receiver using the
Connect GPS  and Fast Connect GPS  functions on the
Attribute, Geometry or Capture function menu.

Connect GPS

This function displays the GPS Receiver dialog
allowing you to initiate a connection as described
above.
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Fast Connect GPS

This function will try to make an immediate
connection to the GPS receiver without showing the
dialog.  If the port is in use by another PocketGIS
peripheral, e.g. a Laser Rangefinder, that peripheral
will be disconnected automatically.  If the
connection cannot be made, or the GPS Receiver
options have not been fully configured, then the GPS
Receiver dialog will be displayed allowing you to
check options and make the connection.

Disconnecting the Receiver

If you wish to disconnect the GPS receiver, for
example if you need to use the serial port for
another purpose, reopen the GPS Receiver dialog
and tap on the Disconnect  Button.

You can also select Disconnect GPS  from the Devices
sub-menu.
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GPS Trail Function

The GPS trail function will automatically digitise a
point, using the current GPS position, at a
predefined interval.  The digitised point will be used
by the Capture or Geometry Tools as the next point
in the current operation.  This function can
therefore be used to add points to an existing
feature or to digitise a new feature or features.

The GPS Trail function is available on the Geometry
or Capture Function menu once the GPS Receiver has
been connected.

Select GPS Trail  to display the GPS Trail dialog box.

Use the Interval  popup list to choose the time
between digitised points and press the Start  button.
GPS points will be digitised at the chosen interval as
long as a current GPS position, which meets any
filter criteria (see filter options earlier in this
chapter), is available.  If the GPS position is lost the
trail will resume when a position is re-acquired.
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To stop the trail manually select Stop GPS Trail  from
the Devices  menu.

GPS Capture Function

The GPS Capture function allows you to capture
features in the background independently of the
Capture Tool.

The GPS Capture function is available on the Capture
Function menu once the GPS Receiver has been
connected.

Select GPS Capture  to display the GPS Capture dialog.
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Use the Map and Layer  popup lists to select the map
layer and the Feature  list to select the feature which
will be captured.  Choose the capture interval from
the Interval  list.  Then press the Start  button.

If a point feature is chosen individual features will
be created at each interval.  If a line or area feature
is chosen then a single feature will be created with
points being added to the feature at the chosen
interval.  The attributes form will not be displayed
for features created by the GPS Capture function but
“Auto Set” attribute values will be stored according
to the definitions setup for the map.

Note that points will not be captured if the GPS filter
criteria are not met at the interval time.

This function is similar to the GPS Trail function
except that it works independently of the Capture
Tool and the current capture feature, whereas GPS
Trail adds points to the current capture feature.

To stop the GPS Capture function select Stop GPS
Capture  from the devices menu.

High Precision Seed Function

The HP Seed function will send position and
standard deviation information to the receiver from
a point which was previously captured from a HP
GPS receiver.  To use this function an HP receiver
must be selected in the ProtocolProtocolProtocolProtocolProtocol item of the GPS
Connect dialog.  Currently the Omnistar 8300HP
receiver is supported for HP use.
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When a HP Receiver has ‘lost lock’ it can take a
period of time before it can provide a HP GPS
position. Seeding the receiver can kick start the
process or requiring ‘lock’ using a previously
captured HP position.

To use the HP Seed function occupy a point that was
previously captured from an HP position. Enter the
Geometry or Capture Map Tool and select HP SeedHP SeedHP SeedHP SeedHP Seed
from the DevicesDevicesDevicesDevicesDevices function sub menu.

You will be prompted to select the point previously
captured using a HP position.

Once a suitable point has been selected the seeding
values from the point will be sent to the receiver. It
is the users responsibility to ensure that they are
occupying the correct point - incorrect results will
be obtained if this function is not used correctly.

Note that the map must have been created using
PocketGIS 1.7.1 or later in order for the HP position
data to have been saved for use by this function.

There is also a HP reset function - select HP Seed
Reset Reset Reset Reset Reset from the Devices Devices Devices Devices Devices menu.
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Reconnect Function

The Reconnect Reconnect Reconnect Reconnect Reconnect function is included on the
Devices Devices Devices Devices Devices sub menu and is available when the GPS
Receiver is connected.  It closes the current
connection and then reconnects.  This can be useful
after a power off if communication with the receiver
is lost (e.g. when using some Bluetooth
implementations).

GPS Digitise Function (Attributes Form)

When connected to a GPS Receiver, the GPS Digitise
function is available from the Attributes Form
Function Menu if a point or text feature is being
modified.

If selected this function will move the features
coordinate to the current GPS position.

Insert GPS Value Function (Attributes Form)

When connected to a GPS Receiver, the Insert GPS
Value function is available from the Attributes Form
Function Menu.
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This function allows certain values derived from the
current GPS position to be inserted into the
currently selected attribute.

Local Shift

A local shift is an additional adjustment in eastings
and northings which is applied after any datum
conversion and once the geographic position
reported by the GPS receiver has been projected into
the chosen coordinate system.  Local shift can be
used to compensate for differences between GPS
generated coordinates and base mapping for a
particular area.  A local shift consists of a number of
points which contain “Original” and “Actual”
coordinates for control points that are known to
you.  The average difference between the original
and actual coordinates for each point is used to
compute the shift.

If you use local shift then the responsibility for
ensuring that coordinates are accurate is 100%
yours.

By default the Local Shift functionality is disabled
and will not appear in PocketGIS menus or controls.
To enable Local Shift controls go to the “Local Shift”
page of the GPS Receiver Options sheet.
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Tick the Enable local shift controls  box.  This options
page also allows you enable or disable the
application of a local shift and also select the current
local shift from any you may have defined.  To have
the local shift applied to coordinates generated from
GPS tick the Enable local shift  box.  To turn off local
shift correction untick this box.  The Shift  popup list
allows you to select the current local shift.

If Local shift controls are enabled then a GPS Local
Shift  sub menu will be present in the Geometry and
Capture function menus.



9-39

GPS Receiver

To use a local shift you must first create a local shift,
or select an existing one.  This can be done from the
New and Select items of the GPS Local Shift  menu
respectively.

Once you have a current local shift you can use the
other functions as follows:

Enable  (or Disable ) - turns the application of the
current local shift on and off.  If a local shift is being
applied then the delta eastings and delta northings
will be shown in <> brackets in the GPS coordinate
display box (providing display of coordinates is
enabled).

Add from GPS  - adds a point to the current local shift.
This option is only available when a position of
acceptable quality is available from the GPS receiver.
You will be prompted to select an existing point from
the map display.  The selected point should be the
point at which you are standing.  The GPS
coordinate is the original point and the selected
coordinate is the actual point.  Note that any
currently active local shift is not applied to the GPS
coordinate used by this function.  A dialog will
appear allowing you to see the coordinates and add
or cancel the new point.
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Add from Point  - adds a point to the current local
shift.  You will be prompted to select an existing
point from the map display.  The selected point will
usually be a control position you previously
captured from GPS WITHOUT LOCAL SHIFT
ENABLED.  In this case the selected point is the
original point - note this is the opposite of the “Add
from GPS” function.  A dialog will appear allowing
you to enter the actual coordinates of the control
point you selected.

Modify  - displays the Modify Shift dialog.
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This allows you to change the name and storage
location of the local shift.  You can also view each of
the points in the shift and enable or disable points
in the shift using the check boxes in the left hand
column.  Double tapping on a coordinate displays a
dialog allowing you to modify the coordinates of the
point.  The Add  button displays a dialog allowing
you to add new points by entering both the original
and actual coordinates.  The Delete  button will delete
the currently selected point from the shift.  The d
East and d North  items show the shift values
incorporating all enabled points.

Delete  - deletes the current local shift - you will be
asked to confirm, but once you have deleted a shift
it cannot be recovered.

GPS Navigation

GPS Navigation is a simple navigation tool which will
give you a direction and distance from your current
position to a preselected point.
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To use GPS Navigation you must first establish a
connection to a GPS receiver.  You must also ensure
that the correct projection / coordinate system is
selected in the GPS Receiver options.

When the GPS Receiver component is installed the
GPS Navigation  option will appear on the Tools  menu.

Select GPS Navigation  to display the GPS Navigation
window.

Enter the coordinates of the position you wish to
navigate to and press Start .  A monitor display will
appear on the right hand edge of the PocketGIS map
display.
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The arrow points towards the target point and the
distance to that point is displayed.  Note that the
information in the navigation monitor is only
updated when you are moving and that the arrow is
relative to your direction of travel and is unrelated
to the map display which is not orientated to your
direction.  The target point, if within the current
map display, is highlighted with a “target” symbol.

To stop navigation select GPS Navigation  from the
Tools  menu and press the Stop  button.

When used with PocketGIS 1.3.1 or later a Navigate To
button is included in the Find by Attribute tool’s
Find Results Window.  Pressing that button will start
navigation to the feature selected in the results list -
see Chapter 5 for more information.
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Laser Rangefinder

This chapter explains how to connect a Laser
Rangefinder to PocketGIS.

The Laser Rangefinder component will work with
various laser devices connected via a serial port.

This chapter is divided into four sections:

• Setting Up Laser Rangefinder

• Connecting to a Laser Rangefinder

• Laser Functions

• Working with Total Stations

The laser connection is controlled from the Laser
Rangefinder dialog which is accessed via the General
Tools Menu.
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Selecting Laser Rangefinder  will display the Laser
Rangefinder dialog.

Setting Up Laser Rangefinder

Before you use Laser Rangefinder you should set the
configuration options.

Bring up the Laser Rangefinder Options dialog by
pressing the Options  button on the Laser Rangefinder
dialog.

Correction Option

This option allows you to view or set the current
compass correction factor.  This factor is an angle
(in degrees) which will be added to all compass
bearings reported by the laser to adjust from
magnetic to grid north.  You can enter a value here
or use the “Azimuth Correction” function to
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compute this value.  The Azimuth Correction
function is described in “Laser Functions” later in
this chapter.

Port Option

This displays the port settings used to communicate
with the laser.  These settings cannot be changed but
this does allow you to check which settings are
required on the laser.

Monitor Option

The Laser Monitor will give feedback on the last shot
received and other information.

Show Laser Monitor

If this box is checked then the Laser Monitor will be
displayed in the top left hand corner of the map
display area.

The following is displayed:

The number of shots (in this case 2).
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The last shot received, this one is a horizontal vector
shot of 14.6 meters at a bearing of 22 degrees.

The compass correction factor in brackets (currently
0).

Note that as soon as a laser shot is used it is
removed from the shot buffer and information about
it will no longer be displayed by the laser monitor.

Bar Options

The Laser Rangefinder component has a toolbars
with shortcuts to some laser functions.  By default
these bars are disabled.  If you tick Show Laser Bar
And / or Show Survey Bar Show Survey Bar Show Survey Bar Show Survey Bar Show Survey Bar on the Bar Options
page then the Laser Bar and / or Survey Bar will
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appear when the laser is connected and you are in a
mode where laser functions can be used (i.e. in the
Geometry and Capture tools).

The functions on the laser bar are described in the
“Laser Functions” section later in this chapter.

The Survey Bar has a number of buttons to give
quick access to some laser functions.  These
functions are: Laser Digitise; Undo / Back; Bilaterate
and Digitise; Triangulate and Digitise; Set Control
Point; Create Target

Supported Lasers and Total Stations

The laser interface protocols of a number of
manufacturers are supported by this release of Laser
Rangefinder. These are described in the respective
sections below:

• Laser Technologies, Inc

• Measurement Devices Ltd

• Leica

• Pentax

• Sokkia

• Lasercraft
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Laser Technologies, Inc

The following LTI interface protocols are supported:

• LTI Criterion

• LTI Impulse

• LTI Impulse with MapStar

• LTI Impulse with Angle Encoder

• Trupulse 200

If you have a laser does not use any of these
protocols, please contact support@pocketgis.com

LTI Criterion LTI Criterion LTI Criterion LTI Criterion LTI Criterion is used when interfacing with
Criterion lasers.

LTI ImpulseLTI ImpulseLTI ImpulseLTI ImpulseLTI Impulse is used when interfacing with Impulse
lasers without the MapStar compass module.

LTI Impulse with MapStarLTI Impulse with MapStarLTI Impulse with MapStarLTI Impulse with MapStarLTI Impulse with MapStar is used when
interfacing with Impulse lasers with the MapStar
compass module.

LTI Impulse with Angle EncoderLTI Impulse with Angle EncoderLTI Impulse with Angle EncoderLTI Impulse with Angle EncoderLTI Impulse with Angle Encoder is used when
interfacing with Impulse lasers with the Angle
Encoder module. Note that this option will set the
Laser Rangefinder control functions to operate in
“Total Station” mode, i.e. angles will be relative to
the baseline angle which has been set. See the
PocketGIS User Manual for more information.

Impulse lasers should be configured to use the
Criterion interface protocol. The following Criterion
data messages are supported by all four options:

Height (HT)
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Tree Diameter (DA)
Conic Projection (CH)
Horizontal Vector (HV)
Horizontal Distance (HD)
Azimuth (AZ)
Conductor Clearance (CN)
Serial ports settings for all options are: speed
4800bps; no parity; 1 stop bit; 8 data bits.

Measurement Devices Ltd

The following MDL interface protocols are
supported:

• Generation II

• Laser Ace

• Laser Ace 300 (NMEA)

• MDL NMEA

• LTI NMEA

• Laser Ace 150

The MDL Laser MDL Laser MDL Laser MDL Laser MDL Laser option will recognise any of these
formats and should be used if you are not using an
angle encoder. If you are using an angle encoder
select MDL Laser with Angle Encoder MDL Laser with Angle Encoder MDL Laser with Angle Encoder MDL Laser with Angle Encoder MDL Laser with Angle Encoder which will
set the Laser Rangefinder control functions to
operate in “Total Station” mode, i.e. angles will be
relative to the baseline angle which has been set. See
the PocketGIS User Manual for more information. If
you have a laser does not use any of these protocols,
please contact support@pocketgis.com
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Serial ports settings for “MDL Laser” and “MDL Laser
with Angle Encoder” are: speed 4800bps; no parity;
1 stop bit; 8 data bits.

Also provided are MDL Laser Ace 300MDL Laser Ace 300MDL Laser Ace 300MDL Laser Ace 300MDL Laser Ace 300 options
which are the same as the MDL LaserMDL LaserMDL LaserMDL LaserMDL Laser options (i.e.
at 4800bps) and MDL Laser Ace 150MDL Laser Ace 150MDL Laser Ace 150MDL Laser Ace 150MDL Laser Ace 150 options
which operate at 9600 bps.

Leica

Leica Device supports the following Leica interface
protocols:

• Vector GIS

• DISTO memo / pro

• GSI Total Station

If you have a laser does not use any of these
protocols, please contact support@pocketgis.com

Serial ports settings for Vector GIS are: speed
1200bps; no parity; 1 stop bit; 8 data bits.

Serial ports settings for DISTO are: speed 9600bps;
even parity; 1 stop bit; 7 data bits.

Seral port settings for the GSI Total Station are:
2400bps; even parity; 1 stop bit; 7 data bits.

Pentax

Pentax Device supports the following Pentax
interface protocols:

• Pentax R100 Series Total Station
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If you have a laser does not use any of these
protocols, please contact support@pocketgis.com

To operate with PocketGIS the following settings
need to be made in the stations “Initial Setting 5”
screen - see the R100 user manual for further
information. The settings are:

Transfer Rate: 1200
Data Bits: 8
Parity: NIL
Stop Bit: 1
Control Signal: ON
XON / XOFF: ON
Through Command: a
Additionally take measurements using single shots -
do not use tracking shots.

Sokkia

Sokkia Device supports the following Sokkia
interface protocols:

• Sokkia Total Station (e.g. SET5F / SET5FS /
SET6F / SET6FS / etc)

If you have a laser does not use any of these
protocols, please contact support@pocketgis.com

Serial ports settings are: speed 1200bps; no parity; 1
stop bit; 8 data bits.

There are two “Sokkia Total Station” options, one for
measurements in metres, the other for
measurements in feet. The device must output
distances in the correct units and angles in gon’s.
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Lasercraft

Lasercraft Device supports the following Lasercraft
interface protocols:

· Lasercraft Laser

The Lasercraft XLR is supported in XLR (Range), XLRi
(Range / Inclination) and XLRic (Range / Inclination
/ Azimuth) modes.

To operate with PocketGIS the following settings
need to be made:

Transfer Rate: 4800
Data Bits: 8
Parity: NIL
Stop Bit: 1
If you have a laser does not use any of these
protocols, please contact support@pocketgis.com

Connecting to a Laser Rangefinder

You can connect various Laser Rangefinders to
PocketGIS.  You will also need a suitable serial
interface cable which will connect the laser to your
handheld device.Open the Laser Rangefinder dialog
and tap on the Connect  Button.
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The Laser Rangefinder will be connected and the
dialog will close.

The Connect Via  popup specifies which serial port the
receiver is connected to.

The Laser  popup specifies which type of laser you
are connecting.  Select the option that best describes
your laser.

Once connected the Laser functions will be available
as described in the next section.

You can also connect to the Laser Rangefinder using
the Connect Laser  and Fast Connect Laser  functions on
the Attribute, Geometry or Capture function menu.

Connect Laser

This function displays the Laser Rangefinder dialog
allowing you to initiate a connection as described
above.

Fast Connect Laser

This function will try to make an immediate
connection to the laser without showing the dialog.
If the port is in use by another PocketGIS peripheral,
e.g. a GPS Receiver, that peripheral will be
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disconnected automatically.  If the connection
cannot be made then the Laser Rangefinder dialog
will be displayed allowing you to check options and
make the connection.

Disconnecting the Laser Rangefinder

If you wish to disconnect the laser, for example if
you need to use the serial port for another purpose,
reopen the Laser Rangefinder dialog and tap on the
Disconnect  Button.

You can also select Disconnect Laser  from the Devices
sub-menu.

Laser Functions

Once a connection has been made with a laser
rangefinder a number of functions are available via
the function menu’s of the Geometry and Capture
tools.
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Some laser functions operate via a number of steps.
You can restart a function at any time by re-selecting
it from the function menu.  The current function is
indicated with a tick in the menu.  You can stop a
function by selecting Cancel Function  from the menu,
or by selecting another function.  You can repeat a
step by selecting Undo  from the function menu.

Laser Control Point

A key concept of the laser functions is the control
point.  This provides the point of reference from
which a laser shot is interpreted.  Many laser
functions are not available until the control point is
established.  Once established the control point is
displayed on screen with a cross:

Other Symbols

Other symbols that can appear when using the laser
functions are as follows.

The circle with a diagonal cross highlights the last
digitised point when capturing features in the
Capture Tool.  When modifying existing features in
the Geometry Tool this symbol denotes the “current
point” (See Chapter 4).
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The circle with a square cross highlights a vertex
that has been selected as part of a laser function.

Laser Mode

The laser mode controls the interpretation of the
laser shot and the behaviour of some functions.  The
mode determines:

• Whether to take a fore shot or a back shot.

• Whether the shot is part of a traverse (i.e.
tracking from one position to another) or a side
shot (i.e. a one off shot).

Fore / Back Shot Mode

In fore shot mode the distance and bearing of a laser
shot are interpreted as starting from the control
point and projecting forward.

In back shot mode the distance and bearing of a
laser shot are interpreted as starting from a
previously unknown position and projecting back to
the control point.

In short: in fore shot mode you stand at the control
point and shoot at something else; in back shot
mode you stand somewhere else and shoot at the
control point.

You can change the fore / back mode using the
menu:
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The dot indicates the current mode.

Alternatively you can use the F and B buttons on the
Laser Bar if it has been enabled.

The current mode is indicated by the depressed
button.

Side Shot / Traverse Mode

In side shot mode a laser function will take a single
laser shot, perform it’s function, and then finish.
The laser control point will not be changed.

In traverse mode a laser function will iterate - it will
take a laser shot, move the control point to the new
position implied by the shot, and then wait to take
another shot and repeat the process.

In short: use side shot mode to take a one off shot;
use traverse mode to take a sequence of shots
moving from one point to the next.

You can change the side shot / traverse mode using
the menu:
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The dot indicates the current mode.

Alternatively you can use the S and T buttons on the
Laser Bar if it has been enabled.

The current mode is indicated by the depressed
button.

Laser Buffer

Laser shots are stored in a buffer prior to being used
by laser functions.  This means you can take several
shots with the laser without having to interact with
PocketGIS.  You can then turn to PocketGIS and use
the laser functions to process the shots in the buffer.
This saves you from having to refer back to the
application on your mobile device after every shot.

The number of shots in the buffer is displayed in the
Laser Monitor which was described earlier in this
chapter.

Note that in traverse mode the laser buffer is cleared
after each shot is processed.  Since you are on the
move only one shot at a time will be relevant.
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Lasers with no Compass

When using a laser which does not have a compass,
you will be prompted for the compass bearing with
the following dialog:

Note that this should be a magnetic bearing and that
the current compass correction factor will be applied
to this value.

Set Control Point Function

The Set Control Point function allows you to define
the current location of the laser control point.  As
described earlier in this chapter the control point is
key in working with the laser functions.

To set the control point first select Set Control Point
from the current tool’s function menu.

The following caption will appear at the top of the
map display area:



10-18

PocketGIS User Manual

If a previous control point has already been
established then you can move the control point
using a laser shot.  If you are in traverse mode you
can establish the control point by following a
traverse line.  If there is no current control point
then you will not be able to use the laser to set the
control point.

You can set the control point by tapping on the map
display.  If the feature snap option is on, and you
tap close to an existing feature, the control point will
be snapped to existing map detail.  You can also tap
on a target position, the control point is set to the
target positions coordinate.

If you have a GPS receiver connected, and the
current location is available, you can set the control
point using GPS.

Bilaterate Control Point Function

The Bilaterate Control Point function allows you to
define the current location of the laser control point
by bilateration from existing map detail.

Note: this function is not affected by the laser mode
and so all laser shots are treated as fore shots.

To use this function first select Bilaterate Control Point
from the current tool’s function menu.
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The following caption will appear at the top of the
map display area:

Select the first vertex on the map display and
following the

caption, stand at the desired position of the control
point and shoot the laser at the feature.

When prompted repeat this procedure for the
second point.

The selected vertexes will be marked with a circle
cross:

When both vertices have been selected and shot at
an initial control point position will be marked with
a cross
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and the confirm / flip dialog will appear.

Press Confirm  if the displayed position is correct, or
press Flip  if the displayed position is on the wrong
side of the target features.  You will now have a new
control point.

Note that if you take the laser shots before starting
this function, the shots will be taken automatically
from the buffer and you will not be prompted for
them.

Laser Digitise Function

The Laser Digitise function is used to digitise new
points using the laser.  This function responds to the
fore / back and side / traverse modes and can thus
be used to follow a traverse line.

To use this function first select Laser Digitise  from
the current tool’s function menu.
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Alternatively you can press the laser digitise button
on the laser bar.

[The Laser Digitise Button is the rightmost as shown
above.]

The following caption will appear at the top of the
map display area:

If you are in fore mode, stand at the control point
and fire the laser at the point to be digitised.  If you
are in back mode then stand at the point to be
digitised and fire at the control point.  A new point
will be digitised - the effect of this will depend on
the current map tool and the tool mode or capture
feature.  If you are in side shot mode the control
point will not change.  If you are in traverse mode
then the control point will move to the location of
the newly created point.
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Set Control & Digitise Function

This function is a combination of the Set Control
Point and Laser Digitise functions.  You will first be
prompted for the control point (which can be set in
the same manner as the Set Control Point function)
and following that you will be prompted for a laser
shot which will digitise a point as described above.

This function is most useful when the laser mode is
set to back shot and traverse.  It can then be used to
digitise a linear feature by taking offsets from known
features or target positions.

The following example shows a situation where three
target points have been established.  The laser
software is set for back shot and traverse shots as we
will be following a line using back shots to reference
points.

Selecting Set Control & Digitise from the current
tool’s function menu. Gives us the following prompt.

We tap on the first target to establish that as the
control point.  The control point cross appears and
the prompt changes to ask use to take a shot at the
target.
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The point is digitised and the laser control point is
moved to the new position.  The display at this point
shows the control point cross and the last digitised
point cross superimposed.  The prompt changes to
ask us for the next control point.

We tap on the second target, the control point cross
moves and the prompt changes to ask for the laser
shot.
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Having taken the shot, as before, the point is
digitised and the laser control point is moved to the
new position.  The prompt changes to ask us for the
next control point.

If we repeat the set control and laser shot process for
the third target we complete our line.

We can then stop the function by selecting Cancel
Function  from the menu, or by selecting another
function.

Create Target Function

The Laser Rangefinder component has the ability to
maintain one or more temporary target positions.
These can be used to mark the position of reflectors
or other temporary reference points for use in laser
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survey operations.  These positions are not
permanently saved to the PocketGIS database and
will be discarded (eventually) once the laser
connection has closed.

To use this function first select Create Target  from the
current tool’s function menu.

The following caption will appear at the top of the
map display area:

If a control point has already been established then
you can create the target using a laser shot.  If you
are in traverse mode you can create a sequence of
targets by following a traverse line.  If there is no
current control point then you will not be able to
use the laser to create a target.

You can create a target by tapping on the map
display.

If you have a GPS receiver connected, and the
current location is available, you can create the
target using GPS.
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Targets are marked with the following symbol:

To make use of a target set the laser control point to
the target position.  You can use the Set Control
Point or Set Control & Digitise functions to do this.
Tapping close to the target will cause the control
point to snap to the target coordinate.

Enter Target Function

The Enter Target function allows you to create a
target by typing a coordinate position.

To use this function first select Enter Target from the
current tool’s function menu.

When the Enter Position dialog appears type in the
coordinate and press enter.
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Enter Control Point Function

The Enter Control Point function allows you to set
the laser control point by typing a coordinate
position.

To use this function first select Enter Control Point
from the Other Laser Functions  sub-menu of the
current tool’s function menu.

When the Enter Position dialog appears type in the
coordinate and press enter.
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Digitise at Control Point Function

This function digitises a point at the current laser
control point.  To do this just select Digitise at Control
Point  from the Other Laser Functions  sub-menu of the
current tool’s function menu.

Azimuth Correction Function

The Azimuth Correction function allows you to
compute the compass correction factor by taking
shots to known map features.  This correction factor
is described earlier in this chapter and provides the
means to correct between magnetic and grid north.
This function is only available if you are using a
laser with a compass.

Before using this function you should establish the
current control point as described previously.  All
laser shots should be taken from that control point.

Note: this function is not affected by the laser mode
and so all laser shots are treated as fore shots.

To use this function first select Azimuth Correction
from the Other Laser Functions  sub-menu of the
current tool’s function menu.
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The following caption will appear at the top of the
map display area:

Tap on the first feature vertex.  The vertex will be
highlighted with a circle cross and the caption will
change to request a laser shot to the selected vertex.
A solid line will represent the path from the control
point to the target vertex.

Shoot the laser at the selected vertex.  A dotted line
will be drawn which represents the laser shot.  The
angle between the solid and dotted lines is the
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difference between magnetic and grid north.  The
caption will change to request that you select the
second target feature point.

Select the second target feature which will also be
highlighted with circle cross and another solid line
will show the path from the control point to the
second target position.  The caption will request a
second laser shot.

Take the second shot.  A second dotted line will be
drawn.

The function will then compute the correction factor
as the average difference between the map and laser
bearings for each target.  You should use the visual
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feedback on screen to verify that “wild distortion” is
not occurring due to the presence of a significant
magnetic anomaly.  The computed factor will be
displayed in a dialog and you can accept or confirm
the new correction factor.

Once accepted the new factor will be applied to all
laser bearings.  The factor will be displayed in the
laser monitor and in the correction options page (as
described earlier in this chapter).

Delete Target Functions

The Delete Target function will delete a single
temporary target position.

To use this function select Delete Target  from the
Other Laser Functions  sub-menu of the current tool’s
function menu.
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You will be prompted to tap on the target to be
deleted.  Tap on the target symbol.

The selected target will be deleted.

The Delete All Targets function will remove all
temporary target positions.  You will be asked to
confirm.

Shot Buffer Functions

The Discard First Shot function will delete the last
laser shot from the buffer.

To use this function select Discard First Shot  from the
Other Laser Functions  sub-menu of the current tool’s
function menu.

The Discard Last Shot function will delete the last
laser shot from the buffer.
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The Empty Shot Buffer function will delete all laser
shots currently in the buffer.  You will be asked to
confirm.

Pole End Digitise Function

This function allows you to digitise the point at the
base of a target pole with two mirrors.  It is
anticipated that this is used to digitise points at the
bottom of holes.

To use this function select Pole End Digitise  from the
Other Laser Functions  sub-menu of the current tool’s
function menu.
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You will be asked for the pole height and the
distance between the mirrors on the pole.  You then
take a shots at the top mirror and the lower mirror
to digitise the point at the end of the pole.

Indirect Digitise Function

This function allows you to digitise a point using a
mirror which is not exactly on the point.

To use this function select Indirect Digitise  from the
Other Laser Functions  sub-menu of the current tool’s
function menu.

This functions asks for two shots:

The first is to the mirror to establish an accurate
distance.

The second is toward the actual point.  This distance
is taken from the first (mirror) shot and the bearing
taken from the second (point) shot.

Measureline Offset Function

This allows you to digitise a point offset from a
measureline.

This function does not use a measuring device but is
included here so temporary targets can be used to
represent the start and end of the measureline.
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To use this function select Measureline Offset  from
the Other Laser Functions  sub-menu of the current
tool’s function menu.

This function asks you to select the start and end
points of the measureline, these can be map features
or temporary targets.

You will be prompted for the length, from the first
point, towards the second point, where the offset
begins.  You will also be asked for the offset distance.
A point is digitised, at the offset distance, to the
“right” of the measureline - the offset is
perpendicular to the measureline.  If you want the
offset to be to the “left” then enter a negative offset.

Bilaterate and Digitise

This function prompts you to take two shots at a
point from different locations - a new position is
then added to the current feature or a point created.
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Triangulate and Digitise

This function prompts you to stand at a point and
take two shots at other known points - a new
position is then added to the current feature or a
point created.

Insert Measurement Function

The Insert Measurement function is available from
the Attributes Form function menu.

To insert a measurement from a laser shot first
complete the operation with the laser so the shot is
in the buffer.  In the attributes form select the
attribute field which is to receive the value and then
choose Insert Measurement  from the Attributes
Function Menu.
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A sub-menu containing the values from the first shot
in the buffer will appear - choose the one you want
to insert into the attribute.  Where a measurement
has more than one value you can insert the various
items into different attributes by selecting the
attribute and then Insert Measurement .

For shots which consist of only one value (e.g.
Height) selecting the value into an attribute will
clear the shot from the buffer.  The next time you
bring up the Insert Measurement  menu the next shot
will be displayed (if any).  Shots which consist of
several values are not cleared automatically.  To
clear a shot select Discard First Shot  from the Other
Laser Functions  sub-menu.

Working with Total Stations

This component can be used with Total Stations as
well as “Laser Rangefinders”.  If you connect to a
Total Station then the operation of the Laser
Rangefinder component is slightly different.

Note that the “Set Control and Digitise” function is
not available when connected to a Total Station.
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In order to digitise using a Total Station the Control
Point needs to be set and, following that, at least one
reference shot to a known coordinate is required to
allow the software to calculate grid bearings.  If you
set the Control Point using the “Bilaterate Control
Point” function then both the station position
(Control point) and the relationship to grid bearings
is established.  If you set the Control Point by
entering a coordinate, from GPS, or by making a shot
to the new position then you will need to make
another shot to a known coordinate (map feature or
target) using the “Alignment Shot” function.

The “Alignment Shot” function asks you to select a
point and then make a shot to it - you can then use
the “Laser Digitise” function to capture data.

It is expected that you will make use of the
temporary target functionality when working with
total stations.  The “Enter Target” function allows
you to create targets by typing in a coordinate.  Use
targets to represent mirrors.  Most functions will
work with targets or map feature points.
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Using the software in “traverse mode” requires an
extra step when working with total stations. Each
time you move the station to the forward point in
the traverse you will need to make an alignment
shot to the previous (or other known) point before
making the next traverse shot.
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Chapter 11

Bar Code Scanner

Bar Code Scanner

The Bar Code Scanner component provides the
capability for PocketGIS to connect directly to a Bar
Code Scanner.  Functions are available from the
function menu of the Attributes Form.

A Bar Code ScannerBar Code ScannerBar Code ScannerBar Code ScannerBar Code Scanner item appears on the
PocketGIS Tools menu.  This allows you to turn the
availability of bar code functions on and off.  If
Enable Scanner FunctionsEnable Scanner FunctionsEnable Scanner FunctionsEnable Scanner FunctionsEnable Scanner Functions is ticked then the bar
code functions will be available from the Attributes
Form's function menu.  The Scanner Scanner Scanner Scanner Scanner item allows
you to select which device to use for bar code
scanning.  The Connect ViaConnect ViaConnect ViaConnect ViaConnect Via item allows you to
choose how to connect to the scanner - for some
scanners there will not be a choice of connection
methods and you will not be able to change this
item.

A number of functions are provided on the
Attributes Form's function menu.  To use the
functions you must first select the text attribute you
want the function to operate on.
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Scan Bar CodeScan Bar CodeScan Bar CodeScan Bar CodeScan Bar Code will activate the scanner and, if the
scan was successful, will place the scanned code into
the selected attribute field.

Insert Last Bar CodeInsert Last Bar CodeInsert Last Bar CodeInsert Last Bar CodeInsert Last Bar Code will insert the last scanned
bar code, if there is one, into the selected attribute
field.

A ScanScanScanScanScan button also appears on the Find by Attribute
window allowing you to scan a bar code into the
search value field.

Husky fex21

The software will work with the built in bar code
scanner on special versions of the Husky fex21
Handheld PC, or a ScanTeam scanner attached to the
serial port of a Husky fex21 Handheld PC. This
component will install, and be available, on any
Husky fex21 machine but the “Husky Bar Code
Scanner” option will only function if the machine
has a built in bar code scanner. The ScanTeam
scanner must be set to use it’s default configuration
in order to work with this software - this includes
serial port settings and output data format.

Socket Bar Code Scanners

All Socket Bar Code scanners are supported. You will
need to install the software that comes with the
Socket scanners before you can use the scanners
with PocketGIS.

OperationOperationOperationOperationOperation
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The Scan Bar CodeScan Bar CodeScan Bar CodeScan Bar CodeScan Bar Code function will only be available
for scanners which can be triggered by software.
These are the Socket In-hand Scan and Husky
scanners. For other Socket scanners the scan is
triggered by using the scanner itself. Similarly the
Scan Scan Scan Scan Scan button on the Find by Attribute tool will only
appear if a software controlled scanner is connected.
Where the software scan controls are not present
just select the field to receive the bar code and
operate the scanner.

If the supplied Socket scanner application are
running you will need to close these before you can
use the scanners with PocketGIS.

The connection to the scanner is normally
maintained automatically once the Enable ScannerEnable ScannerEnable ScannerEnable ScannerEnable Scanner
FunctionsFunctionsFunctionsFunctionsFunctions item is ticked in the Bar Code Scanner
Options window. If the connection has not been
made when you enter the Attributes form then the
Connect Bar Code Scanner Connect Bar Code Scanner Connect Bar Code Scanner Connect Bar Code Scanner Connect Bar Code Scanner function will be
present on the Attributes function menu. Select this
to establish the connection with the scanner.
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Appendix A

Software License

Pocket Systems Software License

1 .1 .1 .1 .1 . Not i ce .Not i ce .Not i ce .Not i ce .Not i ce .  READ THIS AGREEMENT CAREFULLY BEFORE
INSTALLING THE SOFTWARE.  THIS IS A LEGAL AGREEMENT BETWEEN
POCKET SYSTEMS LTD. (“POCKET SYSTEMS”) AND YOU, THE END USER.
POCKET SYSTEMS ARE WILLING TO LICENSE THE ENCLOSED SOFTWARE
TO YOU ONLY ON THE CONDITION THAT YOU ACCEPT ALL OF THE
TERMS CONTAINED IN THIS END-USER LICENSE AGREEMENT.  BY
INSTALLING, COPYING, OR USING THE SOFTWARE ON THE ENCLOSED
DISK, YOU ACCEPT AND AGREE TO BE BOUND BY THE TERMS OF THIS
LICENSE AGREEMENT.  IF YOU DO NOT AGREE TO THESE TERMS,
PROMPTLY RETURN THE UNUSED SOFTWARE AND ALL ACCOMPANYING
MATERIALS IN THIS PACKAGE, ALONG WITH PROOF OF PAYMENT, TO
THE AUTHORISED DEALER FROM WHOM YOU OBTAINED IT FOR A FULL
REFUND OF THE PRICE YOU PAID.

2 .2 .2 .2 .2 . Ownership and L icense .Ownership and L icense .Ownership and L icense .Ownership and L icense .Ownership and L icense .  This is a license agreement and
NOT an agreement for sale.  You own the disk on which the Software are
recorded but Pocket Systems and/or Pocket Systems’ licensors continue
to own the copy of the computer programs, documentation, data, and
other content provided on the disk contained in this package or
accompanying this License, and all other copies that you are authorised
by this Agreement to make (the “Software”).  Your rights to use the
Software are specified in this Agreement, and Pocket Systems retain all
rights not expressly granted to you in this Agreement.  Nothing in this
Agreement constitutes a waiver of Pocket Systems rights under UK,
European, US, or international copyright law or other regional law.

3 .3 .3 .3 .3 . Permit ted Uses .Permit ted Uses .Permit ted Uses .Permit ted Uses .Permit ted Uses .  The Software contains copyrighted material,
trade secrets, and other proprietary material.  You are granted the
following rights to the software:

( a )( a )( a )( a )( a ) Right  to  Instal l  and Use.Right  to  Instal l  and Use.Right  to  Instal l  and Use.Right  to  Instal l  and Use.Right  to  Instal l  and Use.  You may install and use the
Software on one single-user computer in your possession.  The Software
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is “installed” on a computer when it is placed on a computer’s hard disk,
or other secondary storage device.  The Software is “in use” on a
computer when it is executed or loaded into the computer’s RAM or
other primary or storage memory.  You may not under any
circumstances have the Software installed or in use on two or more
computers at the same time.

( b )( b )( b )( b )( b ) Right  to  Copy.Right  to  Copy.Right  to  Copy.Right  to  Copy.Right  to  Copy.          You may copy the Software for back-up and
archival purposes, provided that the original and each copy is kept in
your possession and that your installation and use of the software does
not exceed that allowed in the “Right to Install and Use” section above.

( c )( c )( c )( c )( c ) Right  to  Transfer .Right  to  Transfer .Right  to  Transfer .Right  to  Transfer .Right  to  Transfer .  You may not rent, lend, or lease the
Software.  You may, however, transfer this license to use the Software to
another party on a permanent basis by transferring the Software along
with a copy of this Agreement and all accompanying documentation.
Such transfer of possession terminates your license from us, and you
must destroy all copies of the Software not transferred.  The party to
whom you transfer the Software shall be licensed under this Agreement
upon its acceptance of this Agreement by its initial use of the Software.

4 .4 .4 .4 .4 . Prohibi ted Uses .Prohibi ted Uses .Prohibi ted Uses .Prohibi ted Uses .Prohibi ted Uses .  You may not, without written permission
from us:

( a )( a )( a )( a )( a ) Use, copy, modify, merge, or transfer copies of the Software
except as expressly authorised in this Agreement;

( b )( b )( b )( b )( b ) Use any back-up or archival copies of the Software (or allow
someone else to use such copies) for any purpose other than to replace
an original copy if it is destroyed or becomes defective;

( c )( c )( c )( c )( c ) Disassemble, decompile or “unlock”, reverse translate, or in any
manner decode the Software for any reason other than for the purpose
of achieving interoperability or compatibility;

( d )( d )( d )( d )( d ) Place the Software onto a server so that it is accessible via a public
network such as the Internet; or

( e )( e )( e )( e )( e ) Sublicense, lease, or rent the Software.

5 .5 .5 .5 .5 . L IMITED WARRANTY.LIMITED WARRANTY.LIMITED WARRANTY.LIMITED WARRANTY.LIMITED WARRANTY.

( a )( a )( a )( a )( a ) L imited Warranty.L imited Warranty.L imited Warranty.L imited Warranty.L imited Warranty.  Pocket Systems warrant that, for ninety
(90) days from the date you acquired it from us or our authorised
dealers (1) the Software will perform substantially in accordance with
the user documentation accompanying the Software, and (2) the media
on which the Software is provided to you will be free from defects in
materials and workmanship under normal use and service.

( b )( b )( b )( b )( b ) Exclus ive Remedies .Exclus ive Remedies .Exclus ive Remedies .Exclus ive Remedies .Exclus ive Remedies .  Pocket Systems entire liability and your
sole and exclusive remedy for breach of the foregoing warranty shall be,
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at our option, to either (1) return the price you paid, or (2) repair or
replace the Software or media that does not meet the foregoing limited
warranty if it is returned to us with a copy of your receipt.  This limited
warranty is void if failure of the Software is caused by accident, abuse,
or violation of this license agreement.  Any replacement Software will be
warranted as above for the remainder of the original warranty period, or
thirty (30) days from the date we ship it to you, whichever is longer.

( c )( c )( c )( c )( c ) WARRANTY DISCLAIMER.WARRANTY DISCLAIMER.WARRANTY DISCLAIMER.WARRANTY DISCLAIMER.WARRANTY DISCLAIMER.  POCKET SYSTEMS DO NOT  POCKET SYSTEMS DO NOT  POCKET SYSTEMS DO NOT  POCKET SYSTEMS DO NOT  POCKET SYSTEMS DO NOT
WARRANT THAT THIS SOFTWARE WILL MEET YOURWARRANT THAT THIS SOFTWARE WILL MEET YOURWARRANT THAT THIS SOFTWARE WILL MEET YOURWARRANT THAT THIS SOFTWARE WILL MEET YOURWARRANT THAT THIS SOFTWARE WILL MEET YOUR
REQUIREMENTS OR THAT ITS OPERATION WILL BEREQUIREMENTS OR THAT ITS OPERATION WILL BEREQUIREMENTS OR THAT ITS OPERATION WILL BEREQUIREMENTS OR THAT ITS OPERATION WILL BEREQUIREMENTS OR THAT ITS OPERATION WILL BE
UNINTERRUPTED OR ERROR-FREE.   TO THE EXTENTUNINTERRUPTED OR ERROR-FREE.   TO THE EXTENTUNINTERRUPTED OR ERROR-FREE.   TO THE EXTENTUNINTERRUPTED OR ERROR-FREE.   TO THE EXTENTUNINTERRUPTED OR ERROR-FREE.   TO THE EXTENT
ALLOWED BY LAW, POCKET SYSTEMS EXPRESSLY DISCLAIMALLOWED BY LAW, POCKET SYSTEMS EXPRESSLY DISCLAIMALLOWED BY LAW, POCKET SYSTEMS EXPRESSLY DISCLAIMALLOWED BY LAW, POCKET SYSTEMS EXPRESSLY DISCLAIMALLOWED BY LAW, POCKET SYSTEMS EXPRESSLY DISCLAIM
ALL EXPRESS WARRANTIES NOT STATED HERE AND ALLALL EXPRESS WARRANTIES NOT STATED HERE AND ALLALL EXPRESS WARRANTIES NOT STATED HERE AND ALLALL EXPRESS WARRANTIES NOT STATED HERE AND ALLALL EXPRESS WARRANTIES NOT STATED HERE AND ALL
IMPLIED WARRANTIES,  INCLUDING THE IMPLIEDIMPLIED WARRANTIES,  INCLUDING THE IMPLIEDIMPLIED WARRANTIES,  INCLUDING THE IMPLIEDIMPLIED WARRANTIES,  INCLUDING THE IMPLIEDIMPLIED WARRANTIES,  INCLUDING THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR AWARRANTIES OF MERCHANTABILITY AND FITNESS FOR AWARRANTIES OF MERCHANTABILITY AND FITNESS FOR AWARRANTIES OF MERCHANTABILITY AND FITNESS FOR AWARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE.   IF  THIS SOFTWARE QUALIFIES AS APARTICULAR PURPOSE.   IF  THIS SOFTWARE QUALIFIES AS APARTICULAR PURPOSE.   IF  THIS SOFTWARE QUALIFIES AS APARTICULAR PURPOSE.   IF  THIS SOFTWARE QUALIFIES AS APARTICULAR PURPOSE.   IF  THIS SOFTWARE QUALIFIES AS A
“CONSUMER PRODUCT” UNDER THE MAGNUSON-MOSS“CONSUMER PRODUCT” UNDER THE MAGNUSON-MOSS“CONSUMER PRODUCT” UNDER THE MAGNUSON-MOSS“CONSUMER PRODUCT” UNDER THE MAGNUSON-MOSS“CONSUMER PRODUCT” UNDER THE MAGNUSON-MOSS
WARRANTY ACT,  ANY IMPLIED WARRANTIES ARE LIMITEDWARRANTY ACT,  ANY IMPLIED WARRANTIES ARE LIMITEDWARRANTY ACT,  ANY IMPLIED WARRANTIES ARE LIMITEDWARRANTY ACT,  ANY IMPLIED WARRANTIES ARE LIMITEDWARRANTY ACT,  ANY IMPLIED WARRANTIES ARE LIMITED
TO NINETY (90) DAYS FROM THE DATE YOU ACQUIRED THETO NINETY (90) DAYS FROM THE DATE YOU ACQUIRED THETO NINETY (90) DAYS FROM THE DATE YOU ACQUIRED THETO NINETY (90) DAYS FROM THE DATE YOU ACQUIRED THETO NINETY (90) DAYS FROM THE DATE YOU ACQUIRED THE
SOFTWARE FROM US OR FROM OUR AUTHORISED DEALER,SOFTWARE FROM US OR FROM OUR AUTHORISED DEALER,SOFTWARE FROM US OR FROM OUR AUTHORISED DEALER,SOFTWARE FROM US OR FROM OUR AUTHORISED DEALER,SOFTWARE FROM US OR FROM OUR AUTHORISED DEALER,
AND THEREAFTER ANY IMPLIED WARRANTIES AREAND THEREAFTER ANY IMPLIED WARRANTIES AREAND THEREAFTER ANY IMPLIED WARRANTIES AREAND THEREAFTER ANY IMPLIED WARRANTIES AREAND THEREAFTER ANY IMPLIED WARRANTIES ARE
EXPRESSLY DISCLAIMED.  SOME STATES DO NOT ALLOWEXPRESSLY DISCLAIMED.  SOME STATES DO NOT ALLOWEXPRESSLY DISCLAIMED.  SOME STATES DO NOT ALLOWEXPRESSLY DISCLAIMED.  SOME STATES DO NOT ALLOWEXPRESSLY DISCLAIMED.  SOME STATES DO NOT ALLOW
LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS,LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS,LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS,LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS,LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS,
SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

This limited warranty gives you specific legal rights, and you may also
have other legal rights which vary from state to state.

( d )( d )( d )( d )( d ) Warranty inquiries may be sent to: Pocket Systems Ltd., The Old
Mill, 20 Grange Way, Willington, Bedfordshire, MK44 3QW, United
Kingdom.

6 .6 .6 .6 .6 . L IMITATION OF LIABILITY.LIMITATION OF LIABILITY.LIMITATION OF LIABILITY.LIMITATION OF LIABILITY.LIMITATION OF LIABILITY.  POCKET SYSTEMS  POCKET SYSTEMS  POCKET SYSTEMS  POCKET SYSTEMS  POCKET SYSTEMS
LIABILITY TO YOU FOR ANY LOSSES SHALL BE LIMITED TOLIABILITY TO YOU FOR ANY LOSSES SHALL BE LIMITED TOLIABILITY TO YOU FOR ANY LOSSES SHALL BE LIMITED TOLIABILITY TO YOU FOR ANY LOSSES SHALL BE LIMITED TOLIABILITY TO YOU FOR ANY LOSSES SHALL BE LIMITED TO
DIRECT DAMAGES AND SHALL NOT EXCEED THE AMOUNTDIRECT DAMAGES AND SHALL NOT EXCEED THE AMOUNTDIRECT DAMAGES AND SHALL NOT EXCEED THE AMOUNTDIRECT DAMAGES AND SHALL NOT EXCEED THE AMOUNTDIRECT DAMAGES AND SHALL NOT EXCEED THE AMOUNT
YOU ORIGINALLY PAID FOR THE SOFTWARE.  IN NO EVENTYOU ORIGINALLY PAID FOR THE SOFTWARE.  IN NO EVENTYOU ORIGINALLY PAID FOR THE SOFTWARE.  IN NO EVENTYOU ORIGINALLY PAID FOR THE SOFTWARE.  IN NO EVENTYOU ORIGINALLY PAID FOR THE SOFTWARE.  IN NO EVENT
WILL POCKET SYSTEMS BE LIABLE TO YOU FOR ANYWILL POCKET SYSTEMS BE LIABLE TO YOU FOR ANYWILL POCKET SYSTEMS BE LIABLE TO YOU FOR ANYWILL POCKET SYSTEMS BE LIABLE TO YOU FOR ANYWILL POCKET SYSTEMS BE LIABLE TO YOU FOR ANY
INCIDENTAL,  INDIRECT,  SPECIAL,  OR CONSEQUENTIALINCIDENTAL,  INDIRECT,  SPECIAL,  OR CONSEQUENTIALINCIDENTAL,  INDIRECT,  SPECIAL,  OR CONSEQUENTIALINCIDENTAL,  INDIRECT,  SPECIAL,  OR CONSEQUENTIALINCIDENTAL,  INDIRECT,  SPECIAL,  OR CONSEQUENTIAL
DAMAGES ( INCLUDING LOSS OF PROFITS) ,  EVEN IF  POCKETDAMAGES ( INCLUDING LOSS OF PROFITS) ,  EVEN IF  POCKETDAMAGES ( INCLUDING LOSS OF PROFITS) ,  EVEN IF  POCKETDAMAGES ( INCLUDING LOSS OF PROFITS) ,  EVEN IF  POCKETDAMAGES ( INCLUDING LOSS OF PROFITS) ,  EVEN IF  POCKET
SYSTEMS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCHSYSTEMS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCHSYSTEMS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCHSYSTEMS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCHSYSTEMS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES .DAMAGES .DAMAGES .DAMAGES .DAMAGES .

SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION
OR EXCLUSION MAY NOT APPLY TO YOU.

7 .7 .7 .7 .7 . United States  Government Restr icted RightsUnited States  Government Restr icted RightsUnited States  Government Restr icted RightsUnited States  Government Restr icted RightsUnited States  Government Restr icted Rights.  .  .  .  .   This
section applies to all acquisitions of the Software by or for the United
States Federal Government.  By accepting delivery of the Software, the
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government hereby agrees that the Software qualifies as “commercial”
computer software as that term is used in the acquisition regulations
applicable to this procurement and that the government’s use and
disclosure of the Software is controlled by the terms and conditions of
this Agreement to the maximum extant possible.  This Agreement
supersedes any contrary terms or conditions in any statement of work,
contact, or other document that are not required by statute or
regulation.  If any provision of this Agreement is unacceptable to the
government, Vendor may be contacted at Pocket Systems Ltd., The Old
Mill, 20 Grange Way, Willington, Bedfordshire, MK44 3QW, United
Kingdom, +44 1234 831321.  If any provision of this Agreement violates
applicable federal law or does not meet the government’s actual,
minimum needs, the government agrees to return the unused Software
for a full refund.

The following statement applies only to procurements governed by
DFARS Part 227.4 (OCT 1988):  The enclosed Software is provided with
Restricted Rights -- Use, duplication, or disclosure, by the U.S
Government or any of its agencies or instrumentalities is subject to
restrictions as set forth is subparagraph (c)(1)(ii) [or (i)] of the Rights in
Technical Data and Computer Software clause at DFARS 252.227-7013
(OCT 1988).  Contactor Manufacturer is Pocket Systems Ltd., The Old
Mill, 20 Grange Way, Willington, Bedfordshire, MK44 3QW, United
Kingdom.

8 .8 .8 .8 .8 . Export  Controls .Export  Controls .Export  Controls .Export  Controls .Export  Controls .  This section applies to purchasers in the
United States.  You acknowledge that the Software is subject to the
export control laws and regulations of the United States and any
amendments thereof.  You agree that you will not directly or indirectly
transfer the Software except in compliance with all applicable U.S. export
laws and regulations.

9 .9 .9 .9 .9 . Terminat ion .Terminat ion .Terminat ion .Terminat ion .Terminat ion .  This Agreement is effective until terminated.
You may terminate this Agreement at any time by destroying all copies
of the Software in your possession or by returning all such copies to us.
This Agreement and your right to use this Software automatically
terminate if you fail to comply with any material provision of this
Agreement.  Your license to use this Software also terminates if you
assign this Agreement to someone else.  Upon termination, you must
stop all use of the Software and must destroy any copies that remain in
your possession.  Otherwise, the restrictions on your rights to use the
Software will end upon expiration of the copyright to the Software.

1 0 .1 0 .1 0 .1 0 .1 0 . Miscel laneous Provis ions .Miscel laneous Provis ions .Miscel laneous Provis ions .Miscel laneous Provis ions .Miscel laneous Provis ions .  This Agreement will be governed
by and construed according to the substantive laws of the United
Kingdom [and not by the 1980 United Nations Convention on Contracts
for the International Sale of Goods, as amended].  This is the entire
agreement between us relating to the Software and supersedes any prior
purchase order, communication, advertising, or representation
concerning the Software.  No change or modification of this Agreement
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will be valid unless it is in writing and is signed by us.  If for any reason
a court of competent jurisdiction finds any provision of this Agreement,
or portion thereof, to be unenforceable, that provision of the Agreement
shall be enforced to the maximum extent permissible so as to effect the
intent of the parties, and the remainder of this Agreement shall continue
in full force and effect.

Canadian Transact ions :Canadian Transact ions :Canadian Transact ions :Canadian Transact ions :Canadian Transact ions :  If you acquired this Software in Canada,
you agree to the following:

The parties hereto have expressly required that the present Agreement
and its Exhibits be drawn up in the English language. / Les parties aux
presentes ont expressement exige que la presente convention et ses
Annexes soient redigees en langue anglaise.

Should you have any quest ions or comments concerningShould you have any quest ions or comments concerningShould you have any quest ions or comments concerningShould you have any quest ions or comments concerningShould you have any quest ions or comments concerning
this  l icense,  please do not  hesi tate  to write  to Pocketthis  l icense,  please do not  hesi tate  to write  to Pocketthis  l icense,  please do not  hesi tate  to write  to Pocketthis  l icense,  please do not  hesi tate  to write  to Pocketthis  l icense,  please do not  hesi tate  to write  to Pocket
Systems Ltd,  The Old Mil l ,  20 Grange Way,  Wil l ington,Systems Ltd,  The Old Mil l ,  20 Grange Way,  Wil l ington,Systems Ltd,  The Old Mil l ,  20 Grange Way,  Wil l ington,Systems Ltd,  The Old Mil l ,  20 Grange Way,  Wil l ington,Systems Ltd,  The Old Mil l ,  20 Grange Way,  Wil l ington,
Bedfordshire ,  MK44 3QW, United Kingdom.Bedfordshire ,  MK44 3QW, United Kingdom.Bedfordshire ,  MK44 3QW, United Kingdom.Bedfordshire ,  MK44 3QW, United Kingdom.Bedfordshire ,  MK44 3QW, United Kingdom.
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Technical Support

If you have a problem using PocketGIS, or wish to
report a bug, please contact Pocket Systems in one of
the following ways.  Please give as full a description
of the problem as you can.

By EMail

Send email to support@pocketgis.com

By Post

Write to Technical Support, Pocket Systems Ltd, The
Old Mill, 20 Grange Way, Willington, Bedfordshire, MK44
3QW, UK.

By Phone

Call +44 1234 831321 and ask for Technical
Support.
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Support information may also be available at our
web site:

http://www.pocketgis.com
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Glossary

Attributes information stored about a Feature.

Datum A mathematical model of the earth.

Display Scheme - a Display Scheme controls at which scales map
features are drawn.

Ellipsoid a measurement of the shape of the earth.

Feature a feature is a graphical element on a map such
as a line, point, text, area, etc.  A Layer is
made up of one or more features.

GPS Global Positioning System.  A space based
radio positioning system which provides
accuarate position, velocity and time data.

General Tools are utilities.  They are described in Chapter 6.

Layer a Layer is a grouping of similar Map Features
(e.g. Roads, Buildings, Railways, etc).  A Map
consists of one or more Layers.  A Map View is
made up of one or Layers from any number of
Maps.

Legend a Legend defines how map data is drawn.  It
specifies line styles and symbols.
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Map a Map is the main unit of geographical data
used by PocketGIS.  A Map will comprise of
one or Layers.

Map Projection a mathematical system to represent features
on the earths surface as a flat image.

Map Tools are tools which operate directly on the Map
Display Area.  They are described in Chapter
4.

Map View this determines which map data is displayed
and how and when it appears on the screen.
Map Views are described in Chapter 3.

Map Display Area - the area of the PocketGIS screen where
geograhical map data is displayed.

Navigation Tools are tools which help you navigate around the
Map View.  Navigation & Display Tools are
described in Chapter 5.

NMEA National Marine Electronics Association.
Refers to an industry standard protocol for
interfacing GPS receivers to other devices.

OEM Original Equipment Manufacturer.

OS Ordnance Survey - the National Mapping
Agency of Great Britain.

OSGB36 The Ordnance Survey of Great Britain 1936
mapping datum.  This is the datum used in
Great Britain.

PC Card A periferal card conforming to the Personal
Computer Memory Card International
Association (PCMCIA) interface specification.

UTM Universal Transverse Mercator Map Projection.

View see Map View.

WGS-84 World Geodetic System (1984).  A
mathematical ellipsoid designed to fit the
shape of the entire earth.
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A

Adding
points to a feature  4-34 to 4-35

Aligned Offset  4-51 to 4-58, 12-2 to 12-4
Area Tool  4-10 to 4-12
Attributes Tool  4-12 to 4-28

B

Bar Code Scanner  11-1 to 11-3
Bilaterate Point  4-53 to 4-58, 12-4 to 12-6

C

Capture Information Display  4-47
Capture Tool  4-42 to 4-50
Changing

area features  4-39
feature attributes  4-12 to 4-28
feature geometry  4-28 to 4-41
line features  4-30 to 4-32
point features  4-39 to 4-40
text features  4-40

Create Grid  6-5 to 6-7
Create Simple Map  6-3 to 6-5
Creating

features  4-42 to 4-50
Views  8-3

D

Datum
conversion  9-11
for map projection  9-10

Deleting
areas. See Deleting: lines
lines  4-36 to 4-37
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Maps  6-2
point & text features  4-39
points from area features. See Deleting: points from line

features
points from line features  4-36

Display Units
option  7-2

Displaying
areas  4-10 to 4-12
distances  4-8 to 4-10
feature attributes  4-12 to 4-28
feature type  4-6
the grid reference  4-5 to 4-6

Distance Tool  4-8 to 4-10

E

Edit Functions  4-50, 12-1
accessing  4-51, 12-2
Aligned Offset  4-51 to 4-58, 12-2 to 12-4
Bilaterate Point  4-53 to 4-58, 12-4 to 12-6
Enter Point  4-58, 12-9
Parallel Offset  4-55 to 4-58, 12-6 to 12-8

Editing. See Changing
Enter Point  4-58, 12-9
Extras

Bar Code Scanner  11-1 to 11-3

F

Find by Attribute Tool  5-6 to 5-8

G

General Tools  6-1
button  6-1
Create Grid  6-5
Create Simple Map  6-3
GPS Receiver  9-1
Laser Rangefinder  10-1
Log to Feature  6-8
Log to File  6-7



IN-3

Index

Map Manager  6-2
General Tools Button. See General Tools
Geometry Tool  4-28 to 4-41
GPS  9-1

Antenna Height  9-25
Attributes Form Digitise  9-36
Capture Function  9-33 to 9-34
capturing GPS points  4-49 to 4-50
Connecting

receiver  9-29
Datum

conversion  9-11
for map projections  9-10

DGPS Dialup  9-28
Disconnecting

receiver  9-31
Display Options  9-6
external receiver  9-1
Filter  9-21, 9-26
Filter 2  9-23
GPS Digitise  9-36
GPS Protocols  9-4
GPS Receiver Dialog  9-1
Height Data  9-2
High Precision Function  9-34 to 9-35
Insert GPS Value  9-36 to 9-37
Local Shift  9-28, 9-37
map projection  9-9
Monitor  9-15
Navigation  9-41
NMEA Protocol  9-1, 9-29
Position Standard Deviation Support  9-5
Projections

Ordnance Survey  9-10
Universal Transverse Mercator (UTM)  9-10

receiver  9-29 to 9-31
Recommended Port Speed  9-4
Reconnect Function  9-36
serial interface  9-8
setting points with GPS  4-40 to 4-46
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Setting Up GPS Receiver  9-5
Supported NMEA Position messages  9-2
Trail Function  9-32 to 9-33
UK GPS  9-2
Units

for map projections  9-10
GPS Navigation  9-41 to 9-43
GPS Position Log  9-17 to 9-28
GPS Receiver

GPS Navigation  9-41 to 9-43
GPS Position Log  9-17 to 9-28

Grid Reference Tool  4-5 to 4-6, 5-2 to 5-3

I

Identify Tool  4-6
Image Browser / Selector  4-19 to 4-28

L

Laser Rangefinder  10-1
Bar Options  10-4
Buffer  10-16
Connecting  10-10 to 10-12
Correction Factor  10-2
Disconnecting  10-12
Functions  10-12 to 10-37

Azimuth Correction  10-28 to 10-31
Bilaterate and Digitise  10-35
Bilaterate Control Point  10-18 to 10-20
Control Point  10-13
Create Target  10-24 to 10-26
Delete All Targets  10-31 to 10-32
Delete Target  10-31 to 10-32
Digitise at Control Point  10-28
Discard First Shot  10-32 to 10-33
Discard Last Shot  10-32 to 10-33
Empty Shot Buffer  10-32 to 10-33
Enter Control Point  10-27 to 10-28
Enter Target  10-26 to 10-27
Indirect Digitise  10-34
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Laser Digitise  10-20 to 10-21
Measureline Offset  10-34 to 10-35
Pole End Digitise  10-33 to 10-34
Set Control & Digitise  10-22 to 10-24
Set Control Point  10-17 to 10-18
Sub Section  10-36 to 10-39
Triangulate and Digitise  10-36

Laser Rangefinder Dialog  10-1
Mode  10-14 to 10-16

Fore / Back Shot  10-14 to 10-15
Side Shot / Traverse  10-15 to 10-16

Monitor  10-3
Port Settings  10-3
Supported Lasers and Total Stations  10-5 to 10-10
Working With Total Stations  10-37 to 10-39

Loading map data  2-8 to 2-9
Local Shift  9-37
Log to Feature  6-8
Log to File  6-7 to 6-8

M

Map Manager  6-2 to 6-3
Map Projection  9-9
Map Tools  4-2

Area Tool  4-10 to 4-12
Attributes Tool  4-12 to 4-28

Image Browser / Selector  4-19 to 4-28
Sketch Pad  4-14 to 4-28

button  4-2
Capture Tool  4-42 to 4-50
Distance Tool  4-8 to 4-10
Edit Functions  4-50 to 4-58
Geometry Tool  4-28 to 4-41
Grid Reference Tool  4-5 to 4-6
Identify Tool  4-6
menu  4-2
Pan / Zoom Tool  4-3 to 4-5
Selection List  4-58 to 4-59
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Map Tools Button. See Map Tools
Map Views. See Views
Measuring

areas  4-10 to 4-12
distances  4-8 to 4-10

Metric Conversion
option  7-3

Modifying
Views  3-7 to 3-9

Moving
feature geometry  4-33 to 4-34
point & text features  4-39 to 4-40

Multiple View Mode  8-1
option  7-3

N

Named Extents Tool  5-10
Navigation & Display Tools  5-1

button  5-1
Find by Attribute Tool  5-6
Grid Reference Tool  5-2
menu  5-2
Named Extents Tool  5-10
Redraw Tool  5-6
Save Extent Tool  5-9
Set Scale Tool  5-5
Sheet Reference Tool  5-4

Navigation & Display Tools Button. See Navigation &
Display Tools

O

Options
General  7-2
Image Capture  7-5
Input Panel  7-4

P

Pan
by tapping  4-3 to 4-5
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using buttons  3-3 to 3-4
Pan / Zoom Tool  4-3 to 4-5
Parallel Offset  4-55 to 4-58, 12-6 to 12-8
Power Loss Restore  1-10
Preferences

Map Tools  4-60 to 4-62
Printing

Map Views  3-12

R

Redraw Tool  5-6
Rocovering Installation  1-10
Rotating

point & text features  4-40

S

Save Extent Tool  5-9
Selection List  4-58 to 4-59
Set Scale Tool  5-5 to 5-6
Sheet Reference Tool  5-4 to 5-5
Single View Mode  8-1

option  7-3
Sketch Pad  4-14 to 4-28
Snapping  4-37

T

Total Stations  10-37 to 10-39

U

Units
for map projection  9-10

V

Views  3-1, 3-4 to 3-5
changing  8-2
composition of  3-4 to 3-5
creating  8-3
Modifying  3-7 to 3-9

Display Scheme  3-10 to 3-12
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Legend  3-10
name  3-10

printing  3-12
View Menu  3-6 to 3-7

Z

Zoom
by tapping  4-3 to 4-5
using buttons  3-3 to 3-4
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